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Innledning 1

Hva dette kapittelet inneholder
• Oversikt: side 1

• Brukerhjelp: side 3

• Utstyr som støttes: side 3 

• Hvordan bruke denne brukerhåndboken: side 5

• Brukersikkerhet: side 6

Oversikt

Takk for at du valgte Medtronic Diabetes som din partner på veien til 

å hjelpe pasienter med diabetes med å få bedre kontroll over 

sykdommen. Vi er sikker på at du vil få nytte av CareLink™ Pro-

programvaren som er basert på nyeste teknologi og et enkelt
menybasert brukergrensesnitt.

Denne brukerhåndboken beskriver hvordan du kan bruke CareLink Pro 

for å registrere, lagre og rapportere pasientbehandlingsdata og 

diagnostiske data. Kapittelet beskriver også hvordan du kan få tilgang 

til data fra pumpe, blodsukkermåler og sensor som pasienten har 

lastet opp i CareLink™ Personal – et nettbasert administrasjonssystem 

som brukes sammen med CareLink Pro.
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Funksjoner   

CareLink Pro er en programvare for diabetesbehandling, og den 

installeres på en datamaskin. Den har følgende funksjoner:

• Det kan opprettes pasientjournaler for lagring av data fra pasientens 

utstyr, samt behandlingsdata fra pasientens CareLink Personal-konto. 

• Data fra insulinpumper, monitorer og blodsukkermålere kan sendes til 

systemet, lagres og deretter brukes til å lage rapporter.

• Det kan kobles sammen med CareLink Personal-systemet, og dermed 

få tilgang til utstyrsdata som pasienten har lagret på dette systemet 

(opsjon). Dette er ideelt for å lage oppdaterte rapporter mellom 

konsultasjoner, og det kan redusere behovet for å lese av utstyrsdata 

under konsultasjonen. 

• Det kan lages forskjellige behandlingsrapporter fra utstyrsdataene 

som er lagret i pasientjournalen. Slike rapporter gjør det lettere å 

svare på spørsmål om behandlingen, som for eksempel pasient-

respons, mønstre og unntak.

• Systemet varsler deg når nye programvareoppdateringer kan lastes 

ned og installeres. Dermed er du sikker på alltid å ha de nyeste 

funksjonene. 

• Programvaren har en Guide Me-funksjon som kan hjelpe nye brukere 

av CareLink Pro. Brukerne får tips og hjelp til oppgaver de holder på 

med.

• Den har et integrert hjelpesystem som gir informasjon om forskjellige 

områder.

Sikkerhet   

• CareLink Pro kan beskyttes med passord.

• Overføring av pasientdata fra CareLink Personal er kryptert med 

industristandarden SSL-teknologi (Secure Sockets Layer).

Relevant dokumentasjon     

Denne dokumentasjonen fra Medtronic MiniMed inneholder detaljert 

utstyrsspesifikk informasjon som ikke er inkludert i denne bruker-

håndboken. 

MERK!
Blodsukkermålere fra

andre produsenter: se
instruksjonene fra

produsenten som følger
med blodsukker-

måleren.

• Brukerhåndbok for Paradigm-insulinpumpen

• Brukerhåndbok for Guardian REAL-Time-monitoren

• Brukerhåndbok for sensorfunksjoner

• Brukerhåndbok for ComLink

• Brukerhåndbok for CareLink USB
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Brukerhjelp          

Kontakt den lokale representanten hvis du trenger ytterligere hjelp 

til systemet. På følgende internettadresse finner du internasjonal 

kontaktinformasjon:

http://www.medtronicdiabetes.com/help/contact/locations.html 

MERK! Det kan hende at
noe av utstyret som kan

brukes sammen med
denne programvaren,
ikke er tilgjengelig i

alle land der program-
varen er godkjent for

bruk.

Utstyr som støttes    

CareLink Pro henter data fra følgende utstyr.           

Insulinpumper/glukosemonitorer 

Medtronic MiniMed-pumper 508

Medtronic MiniMed Paradigm-pumper 

511, 512, 712, 515, 715, 522, 722, 
522K, 722K, Paradigm® REAL-Time 
Revel™ (523, 723, 523K, 723K),  
Paradigm® Veo™ (554, 754)  

Guardian REAL-Time-monitor CSS-7100
CSS-7100K

Produsent Blodsukkermålere     

Blodsukkermålere som er 
kompatible med Medtronic 
Diabetes-produkter:

• Bayer CONTOUR® LINK

• LifeScan OneTouch® UltraLink™

• BD Paradigm Link®-blodsukkermåler

LifeScan:

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2

• OneTouch® UltraMini™

• OneTouch® UltraEasy®

Bayers:

• BREEZE™

• BREEZE™ 2

• CONTOUR®
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BD: • Logic®

Bayer’s Ascensia® DEX®-
serien, som omfatter 
følgende kompatible 
blodsukkermålere:

• Ascensia® DEX®

• Ascensia® DEX® 2 

• Ascensia® DEXTER-Z® II

• Glucometer® DEXTER-Z®

• Ascensia® ESPRIT® 2 

• Glucometer® ESPRIT®

• Glucometer® ESPRIT® 2

Bayer’s Ascensia ELITE™-
serien, som omfatter 
følgende kompatible 
blodsukkermålere:

• Ascensia ELITE™

• Glucometer ELITE® XL 

Abbott

• Precision Xtra™ 

• TheraSense FreeStyle®, FreeStyle Flash™
• FreeStyle Papillion™ Mini 
• FreeStyle Mini
• Optium Xceed™
• Precision Xceed™

Roche

• Accu-Chek® Aviva

• Accu-Chek® CompactPlus

• Accu-Chek® Compact

• Accu-Chek® Active

Kommunikasjonsutstyr                 

 Com-Station

til bruk sammen med MiniMed 508-pumpe. 
(Du finner informasjon om nødvendig 
maskinvare i brukerhåndboken for Com-
Station.)

ComLink

til bruk sammen med MiniMed Paradigm-
pumpe og Guardian REAL-Time-monitor. 
(Du finner informasjon om nødvendig 
maskinvare i brukerhåndboken for 
ComLink.) 

Paradigm Link®-blodsukkermåler

til bruk sammen med MiniMed Paradigm-
pumpe og Guardian REAL-Time-monitor. 
(Du finner informasjon om nødvendig 
maskinvare i brukerhåndboken for 
Paradigm Link®-blodsukkermåler.)

CareLink™ USB
til bruk sammen med MiniMed Paradigm-
pumpe og Guardian REAL-Time-monitor.

Datakommunikasjonskabel

til bruk sammen med blodsukkermålere 
fra andre produsenter. Alle produsenter 
av blodsukkermålere leverer en 
datakommunikasjonskabel.

Produsent Blodsukkermålere     
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Tilsvarende utstyr      

Når du skal legge til et apparat i systemet, velger du produsent og 

modell fra en liste. Hvis apparatets produsent og modell ikke er i 

listen, kan du bruke tabellen under til å finne et tilsvarende apparat 

som kan velges.

MERK!
Blodsukkermålere kan

bestilles fra de
respektive

produsentene.

Bestilling                       

Kontakt den lokale representanten når du skal bestille produkter fra 

Medtronic Diabetes. På følgende internettadresse finner du 

internasjonal kontaktinformasjon for Medtronic:

http://www.medtronicdiabetes.com/help/contact/locations.html

Hvordan bruke denne brukerhåndboken

I ordlisten finner du definisjoner av uttrykk og funksjoner. Ord, 

uttrykk og symboler som benyttes i denne brukerhåndboken, står i 

tabellen nedenfor.

Denne brukerhåndboken viser bare eksempler på skjermbilder. 

Skjermbildene på din programvare kan være litt annerledes.

Hvis pasienten bruker ett av disse 
apparatene

Velg dette apparatet

• Bayer’s Ascensia® DEX®

• Bayer’s Ascensia® DEX® 2

• Bayer’s Ascensia® DEXTER-Z® II

• Bayer’s Glucometer® DEXTER-Z®

• Bayer’s Ascensia® ESPRIT® 2 

• Bayer’s Glucometer® ESPRIT®

• Bayer’s Glucometer® ESPRIT® 2

Bayer’s Ascensia® DEX®

Bayer’s Glucometer ELITE® XL Bayer’s Ascensia ELITE™ XL 

Precision Xceed™ Optium Xceed™

Term/stil Betydning

Klikk trykk på venstre museknapp over et element på 
skjermen for å velge det 

Dobbeltklikk trykk to ganger på venstre museknapp over et element 
på skjermen for å åpne det

Høyreklikk trykk på høyre museknapp over et element på skjermen 
for å åpne et annet vindu eller en meny
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Brukersikkerhet      

Indikasjoner for bruk 

CareLink Pro er ment som et verktøy som gjør det enklere å håndtere 

diabetes. Hensikten med dette systemet er å vise dataene som 

overføres fra insulinpumper, blodsukkermålere og kontinuerlige 

glukosemonitorer, som CareLink Pro-rapporter. Rapportene inne-

holder informasjon som kan brukes til å se trender og kartlegge 

daglige aktiviteter, som karbohydratinntak, tidspunkter for måltider, 

insulintilførsel og blodsukkerverdier. 

Advarsler 

• Dette systemet skal bare brukes av helsepersonell som er kjent med 

behandling av diabetes. 

• Systemets rapporter er ikke beregnet til å gi medisinsk rådgivning og 

skal ikke brukes til det. 

• Dette produktet skal bare brukes sammen med utstyr som støttes som 

står nevnt i dette dokumentet. (Se Utstyr som støttes på side 3.)

• Pasienter bør få anbefaling om å kontrollere blodsukkeret minst 

4–6 ganger daglig.

• Pasienter bør få anbefaling om å kontakte diabetesteamet før de gjør 

endringer i deres diabetesbehandling.

• Pasienter bør få anbefaling om kun å ta avgjørelser angående 

behandlingen basert på diabetesteamets retningslinjer og 

blodsukkerverdier, ikke basert på sensorglukoseverdier.

Fet tekst
brukes for et menyvalg eller en menybane. For 
eksempel: Patient > New Patient

STORE BOKSTAVER angir en knapp. For eksempel: SAVE

Kursiv tekst brukes for navn på skjermbilder og felt. For eksempel: 
skjermbildet Reports

MERK! tilleggsinformasjon

FORSIKTIG! advarer mot en fare som, hvis den ikke unngås, kan føre 
til mindre eller moderat skade på programvaren eller 
utstyret.

ADVARSEL! gir deg melding om en potensiell fare som, hvis den 
ikke unngås, kan føre til alvorlig skade eller dødsfall. 
Det kan også beskrive alvorlige bivirkninger og fare-
situasjoner som kan oppstå.

Term/stil Betydning
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Kontraindikasjoner 

Denne programvaren skal ikke brukes med utstyr som ikke står oppført 

i Utstyr som støttes på side 3. Dette produktet skal heller ikke brukes 

i behandlingen av andre medisinske tilstander enn diabetes.

Før du åpner dette programmet, må du lukke følgende programmer 

hvis de er åpne:

• CGMS® System Solutions™-programvare 

• Solutions® Pumps & Meters-programvare 

• Guardian® Solutions®-programvare 

• ParadigmPAL™

• CareLink™ Personal 

• Solutions®-programvare for CGMS® iPro
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Navigere i systemet 2

Hva dette kapitlet inneholder
• Oversikt: side 8

• Åpne CareLink Pro: side 8

• Arbeidsområder: side 10

• Hovedmenylinjen: side 12

• Verktøylinjen: side 12

• Guide Me-funksjonen: side 13

• Learn more-lenker: side 14

• Hjelpesystem: side 14

Oversikt

Bruk dette kapitlet til å gjøre deg kjent med det grafiske bruker-

grensesnittet i CareLink™ Pro. Brukergrensesnittet omfatter menyer, 

en verktøylinje, et navigeringsfelt, arbeidsområder og et Guide Me-

vindu. 

Åpne CareLink Pro                  

1 Dobbeltklikk på CareLink Pro-ikonet på skrivebordet.

Påloggingsbildet vises hvis du må logge deg på med passord. Skrivebordsikon for
CareLink Pro
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a. Skriv inn passordet i feltet Password (Passord).

MERK! Pålogging med
passord er en valgfri

funksjon som stilles inn
under installasjonen.

b. Klikk på LOGIN (Logg på).

Oppstartbildet vises.

2 Klikk på NEW PATIENT (Ny pasient) hvis du vil opprette en ny 

pasientjournal. Klikk på OPEN PATIENT (Åpne pasient) hvis du vil 

åpne en pasientjournal fra en liste over pasienter i systemet.

        

hovedmenyer

aktivt 
arbeidsområde

åpne pasientlistenlegg til ny pasient

navigeringsfelt

statuslinje

knapp for
arbeidsområdet

Reports
knapp for

arbeidsområdet
Devices

knapp for
arbeidsområdet

Profile

vis/skjul Guide Me-vinduet
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Arbeidsområder     

MERK! I de andre
kapitlene i denne

brukerhåndboken finner
du mer informasjon om

arbeidsområdene og
hvordan de brukes.

Hvis en pasientjournal er åpen, kan du klikke på en av knappene i 

navigeringsfeltet for å vise det tilhørende arbeidsområdet. Bruk disse 

arbeidsområdene til å skrive inn eller velge informasjon når du skal 

utføre CareLink Pro-oppgaver for pasienten.

• Profile (Profil): Her kan du legge inn pasientinformasjon som navn og 

fødselsdato. Du kan også koble deg til en pasients CareLink Personal-

konto fra dette arbeidsområdet.

• Device (Utstyr): Her kan du lagre informasjon som trengs for å lese 

av en pasients utstyr.

• Reports (Rapporter): Her kan du definere parametere og velge hvilke 

rapporter som skal lages for pasienten.

Det er bare arbeidsområdet Profile (Profil) som er tilgjengelig for en 

pasient til det er opprettet og lagret en profil for pasienten. Det er 

bare arbeidsområdene Profile (Profil) og Devices (Utstyr) som er 

tilgjengelige for en pasient til det er lagt til utstyr for pasienten.
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Arbeidsområder

Arbeidsområdet Devices (Utstyr)

Arbeidsområdet Profile (Profil)

Arbeidsområdet Reports (Rapporter)

Profil

Utstyr

Rapporter
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Hovedmenylinjen       

Nedenfor ser du hvilke alternativer som er tilgjengelige på hoved-

menyen. Noen av disse menyalternativene kan også velges med 

hurtigtasten som står ved siden av alternativet (f.eks. Ctrl + N for Ny 

pasient). Du kan også bruke navigeringsfeltet eller verktøylinjen når 

du skal velge visse alternativer.

Verktøylinjen     

Verktøylinjen i CareLink Pro gir deg rask tilgang til vanlige 

funksjoner. Verktøylinjen inneholder følgende knapper:

Knapp Navn Funksjon

Legg til pasient
Åpner arbeidsområdet Profile (Profil) slik 
at du kan legge til en ny pasientjournal i 
systemet.

Åpne pasient
Åpner tabellen Patient Lookup 
(Pasientsøk) der du kan velge å åpne en 
eksisterende pasientjournal.

Guide Me
Viser eller skjuler Guide Me-vinduet. 
Klikk på denne knappen hvis du ønsker 
kontekstavhengig hjelp. 
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Pasientfaner

Etter at du har åpnet en pasientjournal, vises det en fane med 

pasientens navn under verktøylinjen. Når en fane er aktiv, betyr det 

at pasientjournalen og arbeidsområdet er aktive og du kan utføre 

CareLink Pro-oppgaver for pasienten.

En pasientjournal kan aktiveres ved å klikke på pasientfanen. Klikk på 

LUKK på pasientfanen for å lukke journalen.

Guide Me-funksjonen     

Guide Me-funksjonen er tilgjengelig i alle deler av CareLink Pro. 

Funksjonen innebærer at det åpnes et vindu med kontekstavhengig 

hjelp og tips til handlinger som kan utføres i den delen av systemet 

som er aktiv. Guide Me-vinduene kan også inneholde lenker til 

>>learn more (lær mer). Når du klikker på disse lenkene, åpnes den 

aktuelle siden i hjelpesystemet med mer informasjon. Guide Me-

funksjonen er aktivert som standard. Du kan imidlertid slå den av når 

som helst.

LUKK-knapp 

inaktiv fane aktiv fane

Lukk-knapp
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Slå Guide Me-funksjonen på og av      
Knappalternativ

• Klikk på knappen HJELP for å slå Guide Me-funksjonen på eller av.

Menyalternativ

• Gå til Help > Guide Me  (Hjelp > Guide Me) for å aktivere eller 

deaktivere funksjonen.

Learn more-lenker    

Learn more (Lær mer) -lenker fører deg til et lignende emne i hjelpe-

systemet. De forekommer i alle deler av systemet, i Guide Me-vinduer 

eller i programvaren. Klikk på >> learn more (lær mer) hvis du er 

usikker på hvordan du skal fortsette eller hvilke verdier du skal legge 

inn.

Hjelpesystem     

Hjelpesystemet hjelper deg mens du bruker CareLink Pro. Det 

inneholder informasjon om hvordan oppgaver utføres i programvaren. 

Hjelpesystemet åpnes på en av følgende måter:

• Velg Help > Medtronic CareLink Pro Help (Hjelp > Hjelp for 

Medtronic CareLink Pro). 

• Trykk på F1.

Hjelp-knapp

learn more-lenke
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Komme i gang 3

Hva dette kapittelet inneholder
• Før du begynner: side 15

• Åpne og lukke pasientjournaler: side 17

• Definere systeminnstillinger: side 18 

Dette kapittelet inneholder informasjon om hvordan du starter 

CareLink™ Pro-programmet, åpner og lukker pasientjournaler og 

definerer innstillinger som gjelder for alle pasientene i systemet. 

Før du begynner

Hvis dette er første gang du bruker CareLink Pro, må du fylle ut 

General preferences (Generelle innstillinger). Se Generelle 

innstillinger på side 19. Disse innstillingene bestemmer hvordan 

visse elementer vises i programvaren og i rapporter, samt hvordan 

du ønsker at systemet skal kommunisere med Internett.

Innstillingene kan defineres når som helst. Det kan være hensikts-

messig å vente med å definere de andre innstillingene til du har 

gjort deg kjent med CareLink Pro.
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Grunnleggende systemoppgaver      

I tabellen nedenfor ser du hvilke hovedoppgaver du antakelig kommer 

til å utføre når du konfigurerer og bruker CareLink Pro for første 

gang. Tabellen viser også hvor i brukerhåndboken du kan finne 

informasjon om de ulike oppgavene.

Trinn Sted

Gjøre deg kjent med bruker-
grensesnittet i CareLink Pro. Kapittel 2, Navigere i systemet

Definere de generelle system-
innstillingene som skal brukes av 
diabetesteamet.

Definere systeminnstillinger på 
side 18

Opprette profiler for alle pasientene. Legge til nye profiler på side 26

Koble deg til pasientens CareLink 
Personal-konto.

Koble seg til CareLink Personal 
(valgfritt) på side 27

Legge til pasientens pumpe og 
blodsukkermålere i profilen. Legge til utstyr på side 37

Lese av data fra pasientens pumpe og 
blodsukkermålere. Lese av utstyrsdata på side 43

Definere og lage rapporter for alle 
pasientene.

Lage rapporter på side 47

Ta regelmessige sikkerhetskopier av 
CareLink Pro-databasen.

Sikkerhetskopiere en database på 
side 61

Oppdatere CareLink Pro.
Legge inn programvareoppdateringer 
på side 60
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Åpne og lukke pasientjournaler

Åpne pasientjournaler         

Opptil seks pasientjournaler kan være åpne samtidig. Se Legge til nye 

profiler på side 26 hvis du ikke har opprettet noen pasientprofiler 

ennå.

1 Gå til File > Open Patient (Fil > Åpne pasient), eller klikk på 

knappen ÅPNE PASIENT. Det vises en pasientliste som ser omtrent 

slik ut:

MERK! Hvis du får
melding om at for

mange pasientjournaler
er åpne, klikker du på

OK, lukker en journal og
fortsetter.

2 Søk etter pasienten ved å skrive inn hele eller deler av pasientens 

navn i feltet Find a Patient (Søk etter pasient). Når pasienten du 

søkte etter er markert, kan du klikke på OPEN (Åpne), dobbeltklikke 

på raden eller trykke på ENTER. Du kan også bla i listen ved hjelp av 

pil opp og pil ned på tastaturet. 

Arbeidsområdet Devices (Utstyr) (hvis du ikke har lagt til utstyr 

ennå) eller Reports (Rapporter) vises for pasienten.

3 Klikk på knappen PROFIL i navigeringsfeltet hvis du vil vise arbeids-

området Profile (Profil).

Lukke pasientjournaler        

1 Kontroller at pasientjournalen du ønsker å lukke, er aktiv (fanen er 

markert).

2 Gjør ett av følgende:

a. Velg File > Close Patient (File > Lukk pasient).

Åpne pasient-
knapp

Profil-knapp
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b. Klikk på LUKK på pasientfanen.

c. Trykk på Ctrl-F4.

Definere systeminnstillinger             

Disse innstillingene gjelder for alle pasientene i systemet. Du finner 

informasjon om innstillinger som bare påvirker enkelte pasienter, 

under Kontrollere rapportinnstillinger på side 51.

Innstillingene vises i følgende grupper:

• General (Generelt)

– Glukoseenheter

– Karbohydratenheter

– Kommunikasjon

– Feilsøking
• Patient Profile (Pasientprofil)

– Velg og rangér datafelter i pasientprofiler.
• Patient Lookup (Pasientsøk)

– Endre rekkefølgen på feltene som vises når du velger Open 
Patient (Åpne pasient) for å vise en liste med pasienter.

• Report Generation (Rapportgenerering)

– Velg hvilke felt som skal vises når du velger hva som skal inngå i 
Daily Detail-rapportene, i datatabellen.

Lukk-knapp
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Generelle innstillinger           
1 Gå til Tools > Options (Verktøy > Alternativer). Følgende vindu 

vises:

2 Klikk på alternativknappen for den verdien du ønsker:

– Glucose Units (Glukoseenheter): mg/dL eller mmol/L

– Carbohydrate Units (Karbohydratenheter): grams (gram) eller 
Exchanges (bytter)

a. Hvis du velger Exchanges (bytter) som karbohydratenhet, må du 
føre inn riktig tall i feltet grams are equal to 1 Exchange (gram 
er lik 1 bytte).

3 Merk av (aktiver) eller fjern merket (deaktiver) i boksen ved siden av 

følgende kommunikasjoner:

MERK! Pass på at du
følger diabetesteamets

eller IT-avdelingens
retningslinjer når du

definerer
kommunikasjons-

innstillingene.

– Automatically check for software updates (Søk etter program-
vareoppdateringer automatisk): Hvis denne funksjonen er 
valgt, sendes det en melding til alle systemene som kjører 
CareLink Pro, når en programvareoppdatering er tilgjengelig. 
Brukeren har da mulighet til å laste ned og installere 
oppdateringene. Hvis du foretrekker kontrollert distribusjon av 
programoppdateringer, kan du fjerne merket i denne 

avmerkingsboksen.

– Synchronize with CareLink™ Personal (Synkroniser med 

CareLink™ Personal): Hvis du ønsker at systemet skal synkronisere 
pasientenes CareLink Personal-data automatisk hver gang du 
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åpner en profil, kan du merke av i boksen Synchronize with 
CareLink Personal (Synkroniser med CareLink Personal). Hvis du 
fjerner merket i denne boksen, må du synkronisere CareLink 
Personal-data manuelt for hver pasient.

4 Merk av eller fjern merket i boksen under Troubleshooting 

(Feilsøking). Hvis boksen er merket av, lagrer programmet en rapport 

med utstyrsavlesinger med tanke på feilsøking.

5 Klikk på OK for å lagre de generelle innstillingene. 

Innstillinger for pasientprofil         

1 Gå til Tools > Options (Verktøy > Alternativer). 

2 Klikk på fanen Patient Profile (Pasientprofil). Følgende vindu vises:

Velge datafelter        
1 Merk av i boksene for å legge til de feltene du ønsker.

MERK! Fornavn og
etternavn kan ikke

fjernes.

2 Fjern merket i boksen hvis du vil fjerne et felt fra profilen.

3 Hvis et felt skal være obligatorisk, merker du av i boksen i kolonnen 

Required (Obligatorisk). Alle felter som er obligatoriske, må fylles ut 

før en profil kan opprettes.

Bruk avmerkingsboksene til å velge hvilke felter du vil ha med i profilen. Bruk pil opp
og pil ned til å sortere feltene i riktig rekkefølge.



Brukerhåndbok for CareLink™ Pro    Komme i gang      21

Legge til egendefinerte felter        

1 Merk av i boksen til venstre for et tomt felt under Custom 

(Egendefinert).

2 Skriv inn tekst for å gi feltet et navn (f.eks. Nærmeste pårørende). 

Dette feltnavnet vises på pasientens profil.

3 Hvis feltet skal være obligatorisk, merker du av i boksen i kolonnen 

Required (Obligatorisk).

MERK! Hvis du vil fjerne
et egendefinert felt fra

profilen, fjerner du
merket i boksen ved

siden av feltet/feltene
du ønsker å fjerne.

Velge rekkefølgen på datafeltene         

• Velg det feltet du ønsker å flytte, og klikk på pil opp eller pil ned for 

å flytte det. (Pilene øverst og nederst brukes til å flytte et felt helt 

til begynnelsen eller slutten av listen.) 

Fullføre innstillingene for pasientprofil

• Klikk på OK når du har fått med alle feltene du ønsker i riktig 

rekkefølge.

Pasientprofilene innholder nå alle feltene som du nettopp valgte, i 

riktig rekkefølge.

Innstillinger for pasientsøk         

1 Gå til Tools > Options (Verktøy > Alternativer). 

2 Klikk på fanen Patient Lookup (Pasientsøk). Følgende vindu vises:

Opp- og ned-
 piler
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Velge hvilke data som skal vises        
• Bruk avmerkingsboksene til å velge hvilken type data du ønsker å vise, 

eller til å fjerne data du ikke ønsker å vise i tabellen Patient Lookup 

(Pasientsøk).

MERK! Fornavn og
etternavn kan ikke

fjernes.

Endre rekkefølgen på innholdet i kolonnen         
• Hvis du vil endre rekkefølgen på kolonnene i tabellen Patient Lookup 

(Pasientsøk), kan du velge den kolonnen du vil flytte, og klikke på pil 

opp eller pil ned. (Pilene øverst og nederst brukes til å flytte en 

kolonne helt til begynnelsen eller slutten av listen.)

MERK! Kolonnen som
står øverst på listen

Column Display Order,
vises som den første

kolonnen i tabellen
Patient Lookup.

Kolonnen nederst vises
som den siste kolonnen i

tabellen.

Fullføre innstillingene for pasientsøk

• Klikk på OK når du har fått med alle datatene du ønsker i riktig 

rekkefølge.

Tabellen Patient Lookup (Pasientsøk) inneholder nå dataene og 

kolonnerekkefølgen du nettopp valgte.

Innstillinger for rapportgenerering        
Datatabellen vises i den delen av rapportgenereringen der du velger 

rapporttyper og hvilke datoer som skal tas med i rapportene. Denne 

Bruk avmerkingsboksene til å velge hvilke data du vil ha med i tabellen Patient Lookup 
(Pasientsøk). Bruk pil opp og pil ned til å sortere kolonnene i riktig rekkefølge.

Opp- og ned-
 piler
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tabellen bør inneholde de dataene som diabetesteamet mener er 

mest nyttig når de skal bestemme hvilke datoer de vil se Daily Detail 

(Daglig detaljer)-rapporter for.

MERK! Du finner mer
informasjon om hvordan

disse innstillingene
påvirker datatabellen,

under Velge rapporttype
og datoer som skal tas

med på side 53.

1 Gå til Tools > Options (Verktøy > Alternativer). 

2 Klikk på fanen Report Generation (Rapportgenerering). Følgende 

vindu vises:

Velge hvilke data som skal vises        

• Bruk avmerkingsboksene til å velge hvilken type data du ønsker å vise, 

eller til å fjerne data du ikke ønsker å vise i datatabellen.

Endre rekkefølgen på kolonnene         

• Hvis du vil endre rekkefølgen på kolonnene i datatabellen, kan du 

velge den kolonnen du vil flytte og klikke på pil opp eller pil ned. 

(Pilene øverst og nederst brukes til å flytte en kolonne helt til 

begynnelsen eller slutten av listen.)

Bruk avmerkingsboksene til å velge hvilken type data du vil ha med i datatabellen. 
Bruk pil opp og pil ned til å sortere kolonnene i riktig rekkefølge.

Opp- og ned-
 piler
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MERK! Elementene som
står øverst på listen
Column Order, vises

som den første kolonnen
i datatabellen.

Elementene nederst
vises som den siste

kolonnen i
datatabellen.

Fullføre innstillingene for rapportgenerering

• Klikk på OK når du har fått med alle dataene du ønsker i riktig 

rekkefølge. 

Datatabellen inneholder nå dataene og kolonnerekkefølgen du 

nettopp valgte.
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Profiler 4

Hva dette kapittelet inneholder
• Før du begynner: side 25

• Legge til nye profiler: side 26

• Redigere pasientprofiler: side 26

• Slette pasientdata fra systemet: side 26

• Koble seg til CareLink Personal (valgfritt): side 27

En profil tilsvarer forsiden på en journal. Den inneholder pasientdata 

som navn og fødselsdato. Du må opprette en profil før du kan hente 

data fra utstyret og bruke dem i behandlingsrapporter.

I arbeidsområdet Profile (Profil) kan du også koble deg til en pasients 

CareLink Personal-konto. Når du er koblet til, kan du hente pasient-

data fra CareLink Personal når som helst, uten at pasienten trenger å 

være til stede.

Før du begynner

Det kan være lurt å tilpasse pasientprofilene slik at de bare 

inneholder den typen informasjon du ønsker å samle inn. Du finner 

mer informasjon om dette under Innstillinger for pasientprofil på 

side 20.

Du trenger også et brukernavn og et passord når du kobler deg til en 

pasients CareLink Personal-konto. Pasienten må være til stede for å gi 

deg disse dataene.
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Legge til nye profiler        

Hver gang du legger til en pasient i CareLink Pro-systemet, må du 

begynne med å fylle ut en profil for pasienten. 

1 Gå til File > New Patient (Fil > Ny pasient), eller klikk på knappen 

LEGG TIL PASIENT. 

Arbeidsområdet Profile (Profil) vises (se eksemplet på side 11). 

MERK! Hvis du vil legge
til eller endre felter i

pasientprofilen, klikker
du på

>>customize fields. Se
Innstillinger for

pasientprofil på side 20.

2 Fyll ut feltene under Patient Profile (Pasientprofil).

3 Klikk på SAVE (Lagre).

Den nye pasientprofilen er lagt til i CareLink Pro-databasen. Det 

vises en melding om at profilen ble lagret.

Hvis et obligatorisk felt ikke er fylt ut når du lagrer en pasientprofil, 

vises det en melding ved siden av feltet. Du kan ikke lagre profilen 

før du har fylt ut feltet.

Redigere pasientprofiler        

1 Kontroller at arbeidsområdet Profile (Profil) er åpent for pasienten.

2 Klikk på EDIT (Rediger).

3 Rediger dataene som skal endres, under Patient Profile (Pasient-

profil).

4 Klikk på SAVE (Lagre).

Det vises en melding om at profilen ble lagret.

Slette pasientdata fra systemet        

1 Kontroller at arbeidsområdet Profile (Profil) er åpent for pasienten. 

2 Kontroller at det er denne pasienten du vil slette. Hvis en pasient-

profil slettes, fjernes alle dataene for pasienten fra CareLink Pro-

databasen. Denne handlingen kan ikke angres.

3 Klikk på >> delete patient record (slett pasientjournal) over 

synkroniseringsdelen av profilen.

Det vises en melding der du gjøres oppmerksom på at alle pasient-

dataene slettes når du sletter journalen. 

4 Klikk på YES (Ja) for å slette pasientjournalen.

Legg til pasient-
knapp
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Koble seg til CareLink Personal (valgfritt)         

Hvis pasienten tillater det, kan du koble deg til pasientens CareLink 

Personal-konto. Dette er et nettbasert verktøy som pasienten kan 

bruke til å laste opp og lagre data fra utstyret og lage en rekke 

behandlingsrapporter. 

Når du har koblet deg til pasientens CareLink Personal-konto, kan du 

hente utstyrsdata som pasienten har lagret der, og bruke dataene i 

CareLink Pro-rapporter. Rapportene kan lages når som helst, også 

mellom konsultasjonene. Dette reduserer også behovet for å lese av 

pasientens utstyr på kontoret.

Hvis en pasient ikke har opprettet en CareLink Personal-konto ennå, 

kan du sende pasienten en e-post der du inviterer vedkommende til å 

opprette en konto. 

Koble seg til en eksisterende konto             
MERK! Pasienten må
være til stede for at

disse trinnene skal
kunne fullføres.

1 Kontroller at du er koblet til Internett.

2 Åpne arbeidsområdet Profile (Profil) for pasienten. 

3 Kontroller at alle obligatoriske felter under Patient Profile 

(Pasientprofil) er fylt ut.

4 Klikk på LINK TO EXISTING ACCOUNT (Koble til en eksisterende 

konto). 

Påloggingssiden for CareLink Personal vises.

5 Be pasienten om å gjøre følgende:

a. Skrive inn Username (Brukernavn) og Password (Passord).
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b. Klikke på SIGN IN (Logg deg på). 

Siden Grant Access (Gi tilgang) vises, ut fra de innstillingene for 

språk og land som pasienten har valgt under registreringen.

6 Be pasienten om å gjøre følgende:

a. Lese vilkårene for bruk.

b. Merke av i boksen ved siden av I agree to the Terms of Use above 
(Jeg samtykker i vilkårene for bruk over) ... 

c. Klikk på GRANT ACCESS (Gi tilgang).

d. Gi beskjed når siden Thank You (Takk) vises.
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Du kan skrive ut vilkårene for bruk til pasienten ved å klikke på PRINT 

(Skriv ut).

Du er nå koblet til denne pasientens CareLink Personal-konto. Se 

Hente data fra en tilkoblet konto på side 30.

Sende invitasjon på e-post           

Gjør følgende når du skal sende en e-post der du inviterer en pasient 

til å opprette en CareLink Personal-konto:

1 Åpne arbeidsområdet Profile (Profil) for pasienten. 

2 Kontroller at alle obligatoriske felter under Patient Profile 

(Pasientprofil) er fylt ut.

3 Klikk på SEND E-MAIL INVITATION TO PATIENT (Send invitasjon til 

pasienten på e-post).
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4 Kontroller at Patient Name (Pasientnavn), Email (E-post) og 

Language (Språk)... er fylt ut riktig.

5 Klikk på SEND. 

Det vises en melding i statusfeltet om at e-posten ble sendt.

Koble en pasients Carelink Personal-konto fra CareLink Pro

Du kan koble en pasients CareLink Personal-konto fra CareLink Pro. 

Dette er bare mulig etter at en CareLink Personal-konto har blitt 

koblet til. Det hindrer CareLink Pro i å fortsette å hente data fra 

pasientens CareLink Personal-konto. Det påvirker ikke pasientens 

egen bruk av CareLink Personal-kontoen.

1 Åpne pasientjournalen og arbeidsområdet Profile (Profil) for 

pasienten.

2 Klikk på UNLINK ACCOUNT (Koble fra konto).

3 Klikk på Yes (Ja) i bekreftelsesmeldingen. Pasientens profil er ikke 

lenger koblet til CareLink Pro.

Statusen er endret til "Not linked" (ikke koblet til), og knappene LINK 

TO EXISTING ACCOUNT (Koble til en eksisterende konto) og SEND 

E-MAIL INVITATION TO PATIENT (Send invitasjon til pasienten på e-

post) vises.

Hente data fra en tilkoblet konto            

Hvis du er koblet til en pasients CareLink Personal-konto, sendes alle 

nye data fra denne kontoen automatisk hver gang du åpner pasientens 

profil i CareLink Pro. 
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MERK! For å forsikre
deg om at dette skjer,

kan du gå til Tools >
Options > General, og

kontrollere at boksen
ved siden av

“Synchronize with
Medtronic CareLink

Personal" er merket av.

Følg disse trinnene for å hente en pasients CareLink Personal-data når 

som helst etter at du har åpnet pasientprofilen:

1 Kontroller at arbeidsområdet Profile (Profil) er åpent for pasienten, 

og at du er koblet til Internett.

2 Velg Tools > Synchronize Patient Data (Verktøy > Synkroniser 

pasientdata).

Synkroniseringsikonet på pasientfanen roterer. Når ikonet stopper, 

er prosessen fullført.

MERK! Hvis pasienten
ikke lenger ønsker at

du skal kunne se
CareLink Personal-

dataene, kan pasienten
slå denne funksjonen av

på menyen OPTIONS.
Det vises en melding
som bekrefter dette.

3 Alle ytterligere data som hentes fra CareLink Personal, vises i 

pasientrapportene. 

Synkroniseringsikon
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Maskinvareoppsett 5

Hva dette kapittelet inneholder
• Før du begynner: side 32

• Koble sammen utstyr: side 33

Dette kapittelet inneholder diagrammer som viser hvordan en 

pasients utstyr kobles til slik at datamaskinen kan lese av data fra 

det.

Du må ha tilgang til pasientens utstyr for å kunne lese av data 

direkte fra utstyret. Du kan imidlertid hente utstyrsdata fra en 

pasients CareLink™ Personal-konto, så slipper du å lese av dataene 

direkte fra utstyret.   

Før du begynner

For å kunne lese av data direkte fra utstyr og overføre dataene til 

datamaskinen, må du ha tilgang til pasientens utstyr og eventuelle 

kabler eller annet nødvendig kommunikasjonsutstyr.



Brukerhåndbok for CareLink™ Pro    Maskinvareoppsett      33

Koble sammen utstyr             

MERK! Du finner mer
informasjon i

instruksjonene som

vises i CareLink™ Pro
mens du leser av

utstyret.

Se på oversiktsdiagrammet for å få et inntrykk av hvordan utstyr skal 

kobles til slik at det kommuniserer med datamaskinen. De øvrige 

diagrammene viser detaljer ved utstyrstilkoblingen. 

MERK! Dette eksemplet
viser hvordan CareLink

USB brukes som
kommunikasjonsutstyr

mellom pumpen og
datamaskinen.

Oversikt over maskinvareoppsett               

TM

CareLinkUSB

CareLink USB

PC

Paradigm-pumpe
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Tilkoblingsdiagrammer                                    

                      

PC-tilkoblinger

USB-
port

Serie-
port
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kobles til
serieporten

på PC-en

ComLink sammen med pumper i Paradigm-serien

Ekstrautstyr

Com-Station sammen med MiniMed 508-pumper eller som 
kommunikasjonsport for blodsukkermåler
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Utstyr 6

Hva dette kapittelet inneholder
• Før du begynner: side 37

• Legge til utstyr: side 37

• Aktivere eller deaktivere utstyr: side 42 

• Lese av utstyrsdata: side 43

Informasjon du trenger for å lese av en pasients utstyr (merke, 

modell, serienummer osv.) lagres i arbeidsområdet Devices 

(Utstyr). Du trenger altså ikke å legge inn informasjonen hver gang 

du leser av data fra utstyret. 

Utstyr i arbeidsområdet Devices (Utstyr) lagres i en av to lister — 

Active Devices (Aktivt utstyr) eller Inactive Devices (Inaktivt 

utstyr). Når du legger til utstyr, plasseres utstyret automatisk i 

listen Active Devices (Aktivt utstyr). Du kan bare lese av data fra 

utstyr som vises på listen Active Devices (Aktivt utstyr). Dette er 

sannsynligvis utstyret som pasienten bruker. 

Annet utstyr som tilhører pasienten, men som ikke er i bruk, kan 

lagres i listen Inactive Devices (Inaktivt utstyr). Dette gjør at 

informasjonen lagres, slik at utstyret kan aktiveres når som helst.
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Før du begynner

Før du kan åpne arbeidsområdet Devices (Utstyr) for en pasient, må 

det være lagret en profil for pasienten i systemet. Se Kapittel 4, 

Profiler.

For at du skal kunne legge til utstyr eller lese av data direkte fra 

utstyret, må utstyret kommunisere med datamaskinen. I Kapittel 5, 

Maskinvareoppsett finner du mer informasjon om hvordan utstyr 

kobles til slik at det kommuniserer med datamaskinen.

Legge til utstyr         

Du kan hente data fra pasientens CareLink Personal-konto hvis 

pasientens utstyr ikke er lagt til ennå. Slikt utstyr legges til 

automatisk når data synkroniseres mellom CareLink Personal og 

CareLink Pro.

MERK! Det kan bare
være én aktiv pumpe
per pasient. Hvis du

legger til en ny pumpe,
flyttes den tidligere

pumpen til den inaktive
listen.

Legge til Medtronic-pumpe eller Guardian-monitor          

1 Kontroller at utstyret du legger til, er koblet til og kommuniserer 

med datamaskinen. (Du finner tilkoblingsinstruksjoner i Kapittel 5, 

Maskinvareoppsett.)

2 Klikk på pasientens fane eller dobbeltklikk på pasientens navn i 

tabellen Patient Lookup (Pasientsøk).

3 Klikk på knappen UTSTYR for å åpne arbeidsområdet Devices (Utstyr)

for pasienten (se eksemplet på side 11).

4 Klikk på ADD DEVICE (Legg til utstyr).

5 Velg Medtronic Pump/Guardian. Veiviseren Add Medtronic 

Pump/Guardian (Legg til Medtronic-pumpe/Guardian) vises.

UTSTYR-knapp
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MERK! Pumpemodellen
står på baksiden av

pumpen eller på
pumpens statusbilde.

6 Velg knappen ved siden av det utstyret du vil legge til. 

Hvis du har valgt MiniMed 508-pumpen, går du videre til trinn 9.

7 Klikk på NEXT (Neste). Siden Serial Number (Serienummer) vises.

MERK! Det vises en
feilmelding hvis du

skriver inn feil
serienummer. Se på

eksemplene på denne
siden og kontroller at
du har skrevet inn de

samme tegnene som på
baksiden av pumpen.

Skriv om nødvendig inn
de seks tegnene på

nytt.

8 Bruk eksemplene på denne siden til å finne det sekssifrede 

serienummeret på utstyret du skal legge til. (Hvis du trenger mer 

hjelp med å finne nummeret, kan du klikke på >>learn more (lær 
mer).) Skriv inn de seks tegnene i feltet Device Serial Number 

(Utstyrets serienummer).

9 Klikk på NEXT (Neste). Det vises en side med Communication Options 

(Kommunikasjonsalternativer) som ser omtrent slik ut:

10 Klikk på nedtrekksmenyen Choose Port (Velg port) og velg den 

porten som ComLink, Paradigm Link®, CareLink USB eller 

Com-Station kobles til på datamaskinen. Hvis du ikke er sikker på 



Brukerhåndbok for CareLink™ Pro    Utstyr      39

hvilken port du skal velge, velger du Auto Detect (or USB) (Autom. 
registrering (eller USB)).

11 Klikk på NEXT (Neste). Siden Test Connection (Test tilkoblingen)

vises og ser omtrent slik ut:

12 Følg eventuelle utstyrsinstruksjoner og klikk på TEST.

En melding angir om tilkoblingen var vellykket. Hvis den var 

vellykket, går du videre til neste trinn. 

MERK! Denne testen
innebærer ingen lesing

av pumpedata; det
kontrolleres bare at

kommunikasjonen
mellom pumpen og

datamaskinen fungerer.

Hvis den ikke var vellykket, må du kontrollere at maskinvaren 

mellom utstyret og datamaskinen er koblet til riktig. Klikk også på 

BACK (Tilbake) på sidene i veiviseren for å kontrollere at du har lagt 

inn riktige utstyrsdata.

13 Klikk på DONE (Ferdig).

Pumpen legges til i listen Active Devices (Aktivt utstyr).
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Legge til en blodsukkermåler            

1 Klikk på pasientens fane eller dobbeltklikk på pasientens navn i 

tabellen Patient Lookup (Pasientsøk).

2 Kontroller at blodsukkermåleren du legger til, kommuniserer med 

datamaskinen. (Du finner tilkoblingsinstruksjoner under Kapittel 5, 

Maskinvareoppsett.)

3 Klikk på knappen UTSTYR for å åpne arbeidsområdet Devices (Utstyr)

for pasienten (se eksemplet på side 11).

4 Klikk på knappen ADD DEVICE (Legg til utstyr).

5 Velg Blood Glucose Meter (Blodsukkermåler). Veiviseren Add Blood 

Glucose Meter (Legg til blodsukkermåler) vises.

6 Klikk på knappen for å velge merket på blodsukkermåleren.

7 Klikk på NEXT (Neste). Siden Meter Model (Blodsukkermålermodell)

vises (denne siden kan se forskjellig ut avhengig av produsenten av 

blodsukkermåleren).
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8 Klikk på den blodsukkermålermodellen du skal legge til. 

9 Klikk på NEXT (Neste). Siden Communication Options 

(Kommunikasjonsalternativer) vises.

MERK! Du kan bare
velge de alternativene

som gjelder for
blodsukkermåleren du

legger til.

10 Klikk på nedtrekksmenyen Choose Port (Velg port) og velg den 

porten som ComLink, Paradigm Link® eller CareLink USB kobles til på 

datamaskinen. Hvis du ikke er sikker på hvilken port du skal velge, 

velger du Auto Detect (Autom. registrering).

11 Klikk på NEXT (Neste). Siden Test Connection (Test tilkoblingen)

vises.
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12 Følg instruksjonene som gis for blodsukkermåleren, og klikk på TEST.

En melding angir om tilkoblingen var vellykket. Hvis den var 

vellykket, går du videre til neste trinn. 

Hvis den ikke var vellykket, må du kontrollere at maskinvaren 

mellom utstyret og datamaskinen er koblet til riktig. Klikk også på 

BACK (Tilbake) i veiviseren for å kontrollere at du har lagt inn riktige 

data.

13 Klikk på DONE (Ferdig).

Blodsukkermåleren legges til i listen Active Devices (Aktivt utstyr).

Aktivere eller deaktivere utstyr      

Pasientutstyr kan flyttes mellom listen Active Devices (Aktivt utstyr)

og Inactive Devices (Inaktivt utstyr) etter behov. Utstyret må være 

aktivt for at du skal kunne lese data fra det. 

Du kan ha så mange blodsukkermålere som du ønsker på listen Active 

Devices (Aktivt utstyr), men bare én pumpe. Kontroller at du ønsker å 

deaktivere den aktuelle pumpen før du legger til en ny pumpe.

Deaktivere utstyr              

1 Klikk på pasientens fane eller dobbeltklikk på pasientens navn i 

tabellen Patient Lookup (Pasientsøk).

2 Klikk på knappen UTSTYR for å åpne arbeidsområdet Devices (Utstyr) 

for pasienten.
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MERK! Utstyret kan
være oppført med et
tilsvarende navn. Se
Tilsvarende utstyr på

side 5.

3 Klikk på >> make this device inactive (deaktiver dette utstyret)
under det utstyret du vil deaktivere.

Utstyret flyttes til listen Inactive Devices (Inaktivt utstyr).

Aktivere utstyr               

1 Klikk på pasientens fane eller dobbeltklikk på pasientens navn i 

tabellen Patient Lookup (Pasientsøk).

2 Klikk på knappen UTSTYR. Arbeidsområdet Devices (Utstyr) vises.

3 Klikk på >> activate this device (aktiver dette utstyret) under det 

utstyret du vil aktivere.

Utstyret flyttes til listen Active Devices (Aktivt utstyr).

Slette utstyr             

Gjør følgende hvis du vil slette utstyr og de tilhørende dataene fra 

arbeidsområdet Devices (Utstyr) og CareLink Pro-systemet:

1 Klikk på pasientens fane eller dobbeltklikk på pasientens navn i 

tabellen Patient Lookup (Pasientsøk).

2 Klikk på knappen UTSTYR for å åpne arbeidsområdet Devices (Utstyr)

for pasienten.

3 Kontroller at utstyret står på listen Inactive Devices (Inaktivt utstyr).

Hvis ikke klikker du på >> Inactivate this device (Deaktiver dette 
utstyret) på listen utstyret står på.

4 Klikk på >> delete this device (slett dette utstyret) under det 

utstyret du vil slette.

Det vises en melding der du gjøres oppmerksom på at utstyret og alle 

tilhørende data vil bli slettet fra pasientjournalen.

5 Klikk på YES (Ja) for å slette utstyret. 

Utstyret og de tilhørende dataene slettes fra arbeidsområdet 

Devices (Utstyr) og fra CareLink Pro-systemet. Data fra dette 

utstyret kan ikke lenger brukes i rapporter.

Lese av utstyrsdata            

En måte å hente utstyrsdata på er å koble seg til pasientens 

eksisterende CareLink Personal-konto. (Se Koble seg til CareLink 

Personal (valgfritt) på side 27.) En annen måte er å lese av dataene 

direkte fra utstyret, som beskrevet i dette kapitlet. 
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CareLink Pro kan lese data fra pasientens utstyr hvis utstyret står på 

listen Active Devices (Aktivt utstyr), og hvis utstyret kommuniserer 

med datamaskinen. Når du har fått dataene, kan du bruke dem til å 

lage rapporter som hjelper deg med å vurdere pasientens behandling. 

(Se Kapittel 7, Rapporter hvis du ønsker mer informasjon om 

rapporter.)

Her er noen eksempler på hvilke typer informasjon CareLink Pro-

systemet samler inn fra insulinpumpen under en opplasting:  

• ulike innstillinger på pumpen, som alarmmodus, lydstyrke og tid

• tilført basalinsulindose

• bolushendelser og tilført mengde

• Bolus Wizard-oppføringer

• primingvolum

• stoppmodusperioder

• sensorglukoseverdier i et bestemt tidsrom – gjelder pumper med 

sensor

Systemet kan også samle inn data fra et Guardian REAL-Time-system, 

blant annet:

• sensorglukoseverdier (SG-verdier)

• koeffisientverdier for glukosesensoren

• kalibreringsfaktorer for glukosesensoren

• måltidsmarkører

• insulininjeksjoner

I tillegg kan det hentes forskjellig informasjon fra blodsukkermålere 

under en opplasting. 

ADVARSEL! Avbryt eller fullfør alle midlertidige basaldoser eller aktive bolusdoser og slett 
alle aktive alarmer. Pumpen stoppes under avlesingen. Kontroller at pumpen starter igjen 
etter at avlesingen er fullført.

FORSIKTIG! Bruk ikke fjernkontrollen mens pumpen leses av. 

Hvis pumpens batteri har lite strøm, sender ikke pumpen data til datamaskinen. Bytt 
batteriet hvis statusen angir at batteriet har lite strøm.    

1 Klikk på pasientens fane eller dobbeltklikk på pasientens navn i 

tabellen Patient Lookup (Pasientsøk).

2 Kontroller at pasientens utstyr kommuniserer med datamaskinen. 

(Se Kapittel 5, Maskinvareoppsett.)

3 Klikk på knappen UTSTYR for å åpne arbeidsområdet Devices (Utstyr) 

for pasienten.
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MERK! Utstyret kan
være oppført med et
tilsvarende navn. Se
Tilsvarende utstyr på

side 5.

4 Finn utstyret du ønsker å hente data fra, på listen Active Devices 

(Aktivt utstyr) og kontroller at dataene under Choose port (Velg 

port) er riktige.

– Klikk på nedtrekksmenyen Amount of Data (Datamengde) hvis 
utstyret er en pumpe, og velg hvor mange pumpedata du vil at 
CareLink Pro skal lese av.

5 Klikk på den tilhørende knappen for READ DEVICE (Les av utstyr).

6 Følg spesifikke instruksjoner for utstyret og klikk på OK.

7 En fremdriftsindikator i CareLink Pro angir hvor stor del av 

avlesingen som er fullført.

8 Hvis du klikker på CANCEL (Avbryt) under avlesingen, vises det en 

melding om at du kan miste alle dataene som er lest av så langt, hvis 

du avbryter handlingen. Du må klikke på READ DEVICE (Les av utstyr) 

(trinn 5) for å starte opplastingen på nytt.

– Klikk på YES (Ja) for å avbryte. 

– Klikk på NO (Nei) hvis du vil fortsette avlesingen.

Når systemet er ferdig med å lese av dataene fra utstyret, vises det 

en melding der det bekreftes at avlesingen er fullført.

9 Klikk på OK. 

– Følg instruksjonene for å deaktivere stoppmodus hvis utstyret er 
en pumpe.

Hvis CareLink Pro ikke klarer å hente data fra utstyret, finner du mer 

informasjon i Kapittel 9, Feilsøking.
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Rapporter 7

Hva dette kapittelet inneholder
• Før du begynner: side 46

• Lage rapporter: side 47

• Om rapporter: side 55

• Eksportere data: side 57

I arbeidsområdet Reports (Rapporter) i CareLink™ Pro kan du 

konvertere data fra utstyret til klinisk nyttig informasjon. Under 

Om rapporter på side 55 ser du hvilke typer rapporter du kan lage. 

Rapportene kan lages på skjermen, sendes direkte til en skriver 

eller lagres som TIFF- eller PDF-filer som kan legges ved en 

elektronisk pasientjournal (EPJ). Du kan lage flere typer rapporter 

i en enkelt handling.

Dataene som vises i disse rapportene, hentes fra pasientens 

utstyr, fra pasientens CareLink Personal-konto eller fra begge 

stedene. 

Før du begynner

Hvis du vil vise data fra en bestemt periode i en rapport, må du 

hente data fra pasientens utstyr for den perioden. Det kan også 

hende at du må koble pasientens utstyr til datamaskinen og hente 

aktuelle data før du kan lage rapporter.

Sørg for at du går gjennom trinnet Verify Report Settings 

(Kontroller rapportinnstillinger) før du lager en rapport. Her kan 
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du fininnstille en rapport slik at du får med de pasientdataene du 

ønsker.

Lage rapporter       

I de følgende avsnittene beskrives de trinnene som må fullføres når 

du skal lage en eller flere rapporter.

Åpne arbeidsområdet Reports (Rapporter)      

1 Klikk på pasientfanen eller klikk på knappen ÅPNE PASIENT og 

dobbeltklikk på pasientens navn.

Arbeidsområdet Reports (Rapporter) vises (se eksemplet på side 11).

MERK! Klikk på SYNC
DATA for å sikre at du

har de siste utstyrs-
dataene fra pasientens

CareLink Personal-
konto.

Velge rapportperiode        

1 Hvis du vil endre hvor lang tid rapporten(e) skal omfatte, klikker du 

på nedtrekksmenyen Duration (Varighet) og velger tidsrom. 

(Maksimal varighet er 12 uker.)

2 Fra og med- og til og med-dato stilles inn automatisk, med mindre du 

velger alternativet custom date range (egendefinert datointervall).

MERK! Hvis du velger et
lengre datointervall enn

det som er tillatt, får
du en feilmelding. Endre

varigheten eller
datoene.

Hvis du vil stille inn datoene selv, klikker du på nedtrekksmenyen 

From (Fra og med) eller Through (Til og med) og velger ønsket 

måned, dato eller år. 

Kalender

Kalenderfeltet i arbeidsområdet Reports (Rapporter) viser rapport-

informasjon for tre måneder. Det inneholder en liste med utstyr og 

viser hvor mye data som fins for utstyret i de valgte tre månedene. 

Det viser også varigheten på rapportperioden for de valgte tre 

månedene. 

Åpne pasient-
knapp

utstyrsdata
rapportperiode

kalender
måned
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Overlapping mellom utstyrsdataene og rapportperioden betyr at det 

fins data for deler av eller hele rapportperioden som vises.

Til å begynne med vises de tre siste månedene i kalenderfeltet. Hvis 

du vil se andre måneder, klikker du på pilknappene på begynnelsen 

eller slutten av perioden.

Velge data som skal tas med       

1 Hvis pasienten bruker en blodsukkermåler som kobles til pumpen, 

må du velge et av følgende alternativer for rapportering av data fra 

blodsukkermåleren: 

– fra pumpen: Fordelene med dette valget er blant annet at du 
bare trenger å lese av data fra pasientens pumpe. Blodsukker-
verdiene er tidsstemplet av pumpen og verdiene knyttet direkte 
til eventuelle Bolus Wizard-beregninger som brukes. En ulempe er 
at hvis det oppstår kommunikasjonsproblemer mellom pumpen og 
blodsukkermåleren, kan det hende at det ikke rapporteres 
blodsukkerverdier for den perioden. Dessuten, hvis pasienten har 
en MiniMed Paradigm-pumpe som er eldre enn 522/722-modellen, 
rapporteres ikke blodsukkerverdier fra Bolus Wizard-beregninger 
hvis pasienten ikke gjør noen endringer på grunnlag av verdiene.

– fra blodsukkermåleren/-målerne: Fordelen med dette valget er 
at alle verdiene som lagres i den tilkoblede blodsukkermåleren, 
rapporteres. Ulempen er at du må sørge for at pumpens og 
blodsukkermålerens klokker er synkronisert for at dataene fra 
blodsukkermåleren og pumpen skal kunne samordnes. Du må også 
lese av data fra pumpen og blodsukkermåleren separat.

2 Merk av i boksen ved siden av utstyret hvis du vil at data fra utstyret 

skal tas med i rapportene. 

Du kan ikke legge til utstyr som er utelukket på grunn av valget du 

tok i trinn 1. Hvis du vil endre dette, velger du det andre 

alternativet for rapportering av data fra blodsukkermåleren.

Overlapping mellom utstyrsdataene 
og rapportperioden

pilknapper
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3 Fjern merket i boksen ved siden av utstyret hvis du ikke vil at data 

fra det utstyret skal tas med i rapportene. 

Du kan ikke fjerne merket fra utstyr som er tatt med på grunn av 

valget du tok i trinn 1. Hvis du vil endre dette, velger du det andre 

alternativet for rapportering av data fra blodsukkermåleren.

Kontrollere om det fins utstyrsdata        

1 Se på kalenderfeltet i arbeidsområdet Reports (Rapporter) og legg 

merke til om det er overlapping mellom rapportperioden og 

utstyrsdataene (se eksemplet på side 48).

2 Hvis det er overlapping for hele rapportperioden, har du data til 

rapporten(e). Du kan klikke på NEXT (Neste) og gå til Kontrollere 

rapportinnstillinger på side 51.

3 Hvis det ikke er noen overlapping, eller hvis det ikke er nok over-

lapping, har du noen valg:

– Endre rapportperioden (se Velge rapportperiode på side 47).

– Hente ytterligere utstyrsdata (se Hente ytterligere utstyrsdata 
på side 49).

Hente ytterligere utstyrsdata         

1 Klikk på knappen READ DEVICE (Les av utstyr) for utstyret hvis du vil 

hente flere data fra utstyret.

Feltet for avlesing av utstyret vises.

ADVARSEL! Avbryt eller fullfør alle midlertidige basaldoser eller aktive bolusdoser og slett 
alle aktive alarmer. Pumpen stoppes under avlesingen. Kontroller at pumpen starter igjen 
etter at avlesingen er fullført.

felt for avlesing av utstyret

knappen READ DEVICE 
(Les av utstyr)
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FORSIKTIG! Bruk ikke fjernkontrollen mens pumpen leses av. 

Hvis pumpens batteri har lite strøm, sender ikke pumpen data til datamaskinen. Bytt 
batteriet hvis statusbildet på utstyret angir at batteriet har lite strøm.    

2 Kontroller at dataene i feltet Choose port (Velg port) stemmer for 

utstyret.

Hvis du vil endre denne innstillingen, klikker du på nedtrekksmenyen 

for feltet og velger en annen innstilling.

3 Kontroller at utstyret er koblet til datamaskinen. 

4 Hvis utstyret er en pumpe, kan du angi hvor mye data du vil hente 

fra den. Klikk på nedtrekksmenyen Amount of Data (Datamengde) og 

velg mengde.

MERK! Hvis du velger All
available data, leser

systemet av alle
dataene fra pumpen.

Dermed overskrives alle
doble data i systemet.

5 Klikk på READ DEVICE (Les av utstyr). Pass på at du leser meldingen 

som vises nøye fordi den inneholder konkrete instruksjoner for 

avlesing av pumpen.

6 Følg instruksjonene og klikk på OK. 

Fremdriftsindikatoren for avlesing av utstyr vises.

Du kan avbryte avlesingen når som helst ved å klikke på CANCEL 

(Avbryt).

Det vises en bekreftelsesmelding om at avlesingen er fullført.

7 Klikk på OK.

Det vises nå utstyrsdata i kalenderen.

8 Klikk på NEXT (Neste) øverst i arbeidsområdet Reports (Rapporter).

Trinnet Verify Report Settings (Kontroller rapportinnstillinger)

vises. Her kan du kontrollere at innstillingene for denne pasienten er 

riktige før du lager rapporten(e).
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Kontrollere rapportinnstillinger           

1 Kontroller at innstillingene for Glucose Target (Målområde for 

glukoseverdier) er riktige. Skriv inn disse verdiene eller klikk på pil 

opp eller pil ned i feltene Low (Lav) og High (Høy) for å øke eller 

senke verdiene.

MERK! Du kan ha opptil
fem måltidsperioder.

Standardinnstillingene
er frokost, lunsj og

middag.

2 Klikk på ADD MEAL (Legg til måltid) hvis du vil legge til en ny 

måltidsperiode. Klikk hvor som helst innenfor en av måltids-

periodene langs tidslinjen for å redigere en eksisterende måltids-

periode.

Vinduet for redigering av måltidsperioder, under tidslinjen, blir 

aktivt.

3 Skriv inn tekst eller klikk på pilene for å velge de innstillingene du 

ønsker.

MERK! Hvis du vil bruke
disse innstillingene til

bare dette måltidet, må
du fjerne merket i

boksen ved siden av Use
these parameters for all
of this patient’s meals.

– Meal Name (Måltidsnavn): navnet du vil gi måltidsperioden.

– Meal Time Period (Tidsintervall for måltidet): tidsintervallet for 
måltidet.

– Pre-Meal BG Target (Målområde for glukoseverdi før måltidet) 
(mg/dL eller mmol/L): øvre og nedre målområde for pasientens 
glukoseverdi før måltidet.

tidslinje

måltidsperiode 

felter for redigering av måltidsperioder

leggetid og morgen
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– Pre-Meal Analysis Period (Tidsrom for analyse før måltid): hvor 
lenge glukoseverdiene skal analyseres før starten på måltidet. 
Glukoseverdiene som registreres i denne perioden, brukes i en 
detaljert rapportanalyse.

– Post-Meal BG Target (Målområde for glukoseverdi etter 
måltidet) (mg/dL eller mmol/L): øvre og nedre målområde for 
pasientens glukoseverdi etter måltidet.

– Post-Meal Analysis Period (Tidsrom for analyse etter måltid):
hvor lenge glukoseverdiene skal analyseres etter måltidet. 
Glukoseverdiene som registreres i denne perioden, brukes i en 
detaljert rapportanalyse.

MERK! Måltidsperiodene
kan ikke overlappe

hverandre, men start-
og sluttlinjene kan

tangere hverandre.
Tidsperiodene må være

minst 60 minutter
lange.

Du kan endre lengden på en eksisterende måltidsperiode eller 

morgen- og leggetidperioden ved å klikke på start- eller sluttlinjen 

og dra perioden langs tidslinjen. 

4 Hvis du vil bruke innstillingene for dette måltidet på alle de andre 

måltidene for pasienten, må du kontrollere at boksen ved siden av 

Use these parameters for all of this patient’s meals (Bruk disse 

innstillingene på alle måltidene for denne pasienten) er merket av.

5 Klikk på SAVE (Lagre) når du er ferdig med å opprette eller redigere 

en måltidsperiode.

6 Klikk på DELETE MEAL (Slett måltid) hvis du vil slette en måltids-

periode. Klikk på DELETE (Slett) når du blir bedt om å bekrefte.

7 CareLink Pro kan huske disse innstillingene for denne pasienten 

neste gang du skal lage en rapport for pasienten. Klikk på SAVE 

klikk på start- eller sluttlinjen og dra og slipp den på tidslinjen

tidslinje

markør for avlesing av blodsukkermåleren
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SETTINGS (Lagre innstillinger) for å lagre innstillingene for denne 

pasienten.

8 Klikk på NEXT (Neste) øverst i arbeidsområdet Reports (Rapporter).

I dette trinnet kan du velge og lage rapporter. Du kan velge en liste 

med rapporttyper eller en datatabell som hjelper deg med å velge å 

ta med eller utelate data for visse dager i Daily Detail (Daglig 

detaljer)-rapporten(e). 

9 Klikk på utskriftsikonet hvis du vil skrive ut skjermbildet.

MERK! Klikk på
>>customize columns

hvis du vil endre hvordan
datatabellen vises. Se

Innstillinger for
rapportgenerering på

side 22.

Velge rapporttype og datoer som skal tas med           

1 Merk av i boksen ved siden av rapporten(e) du vil ta med i rapport-

oppsettet.

2 Hvis det er lest av data fra en pumpe eller Guardian-monitor mer 

enn en gang i denne rapportperioden, kan det hende det fins flere 

sammendrag av utstyrsinnstillingene: 

a. Kontroller at boksen ved siden av Device Settings Snapshot 
(Sammendrag av utstyrsinnstillinger) er merket av. 

b. Klikk på pilen i datofeltet og velg dato og klokkeslett for 
sammendraget. 

– Pumper: Velg et sammendrag fra pasientens pumpe.

– Guardian: Velg et sammendrag fra pasientens Guardian-monitor. 

Hvis et av feltene er nedtonet, fins det ingen sammendrag for 

rapportperioden.

Datatabell

skriv
ut
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3 Bla gjennom datatabellen og les gjennom informasjonen som er 

tilgjengelig for Daily Detail (Daglig detaljer)-rapportene. 

– Du kan sortere dataene i hver kolonne. Klikk på kolonne-
overskriften hvis du vil sortere dataene i stigende rekkefølge. 
Klikk på kolonneoverskriften en gang til for å sortere dataene i 
synkende rekkefølge.

MERK! Hvis det ikke
finnes data for en

bestemt dato, kan ikke
datoen velges.

4 Merk av i boksen på datatabellradene for de datoene du ønsker en 

Daily Detail (Daglig detaljer)-rapport for. 

– Du kan ta med eller velge bort alle datoene for Daily Detail 
(Daglig detaljer)-rapporter med et klikk, ved å merke av i boksen 
øverst i avmerkingskolonnen i datatabellen.

Lage rapporter                                  

1 Etter at du har kontrollert rapportinnstillingene, klikker du på 

GENERATE REPORTS (Lag rapporter) øverst i arbeidsområdet Reports 

(Rapporter).

Det vises en liste med alternativer.

2 Velg om du vil forhåndsvise, skrive ut eller lagre rapporten(e).

Hvis du velger Preview (Forhåndsvisning), vises vinduet Report 

Preview (Forhåndsvisning av rapport).

3 Klikk på pilknappene for å navigere gjennom rapporter på flere sider.

4 Klikk på en av de andre knappene øverst i vinduet Report Preview 

(Forhåndsvisning av rapport) hvis du vil lagre eller skrive ut 

rapporten(e).

5 Lukk dette vinduet ved å klikke på LUKK i øvre høyre hjørne av 

vinduet.LUKK forhåndsvisning-
knapp
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Om rapporter         

I denne delen beskrives de forskjellige rapportene. Du finner mer 

informasjon om rapportene samt eksempler på rapportene i 

Referanseveiledning for rapporter. Du kan åpne Referanseveiledning 

for rapporter via CareLink Pro-programvaren:

1 Help > View Report Reference Guide (PDF) (Hjelp > 

Referanseveiledning for rapporter (PDF)). 

2 Velg et språk for Referanseveiledning for rapporter.

CareLink Pro-rapporter har følgende elementer til felles: 

• Overskrift — Overskiften inneholder informasjon som identifiserer 

rapporten, for eksempel rapportens navn, pasientens navn og hvor 

dataene kommer fra.

• Karbohydrater og blodsukkerverdier — Karbohydratenheter vises i 

kursiv og blodsukkerverdier vises i fet skrift på kurver og i tabeller.

• Helgedata — Helgedager står i fet skrift slik at de er lette å se.

• Symbolforklaringer — Det vises en liste med symbolforklaringer 

nederst på hver rapport. Selv om symbolene brukes i flere rapporter, 

er symbolforklaringene unike for hver rapport.

Rapporten Adherence (Respons)       

Denne rapporten inneholder data om hvordan insulinpumper og 

sensorer brukes, samt pasientatferd som har betydning for 

behandlingen. Rapporten besvarer spørsmålet: "Var det tilstrekkelig 

data til å gi et nøyaktig bilde av hvordan pasienten bruker insulin-

pumpen og sensoren, hvis dette er aktuelt?" Den besvarer også 

spørsmålet: "Følger pasientene behandlingen som foreskrevet?" Den 

viser også om du trenger å snakke med pasienten om hvordan han 

eller hun håndterer diabetesen.

Rapporten Sensor and Meter Overview (Oversikt over sensoren og 
blodsukkermåleren)       

Rapporten Sensor and Meter Overview (Oversikt over sensoren og 

blodsukkermåleren) inneholder en grafisk oversikt over pasientens 

daglige glukoseverdier og gjennomsnittsverdier fra blodsukker-

måleren og viser blant annet data per time for hele døgnet og 

hvordan verdiene er i forhold til måltids- og søvnmønster. Rapporten 

inneholder også statistikk over pasientens glukoseverdier og insulin-

bruk. 
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En lignende analyse av sensordata genereres på forsiden av denne 

rapporten hvis det foreligger sensordata. Hvis det ikke foreligger 

sensordata, inneholder forsiden dataene fra blodsukkermåleren.

De siste sidene av rapporten viser graden og kvaliteten på pasientens 

glykemiske kontroll, registrering av karbohydrater og insulindoser dag 

for dag. På hver side vises det hvordan kontrollen har variert fra dag 

til dag i hele rapportperioden med maksimalt 14 dager per side.

Rapporten Logbook (Loggbok)      

Rapporten Logbook (Loggbok) viser glukose-, karbohydrat- og 

insulindata fra blodsukkermåleren for hver dag i rapportperioden. 

Den inneholder en oversikt over registrerte hendelser per time, samt 

daglige gjennomsnittsverdier og totalverdier. Hver side inneholder 

opptil 14 dager. Hvis rapportperioden er lengre enn 14 dager, lages 

det ekstra sider.

Rapporen Device Settings Snapshot (Sammendrag av 
utstyrsinnstillinger)        

Denne rapporten inneholder et sammendrag av innstillingene for 

pasientens pumpe eller Guardian REAL-Time-monitor på en konkret 

dato og et konkret klokkeslett. Den kan hjelpe deg med å forstå andre 

rapporter eller bare dokumentere pasientens innstillinger. 

Pumpe- eller monitorinnstillingene registreres bare når utstyret leses 

av. Hvis utstyret ikke har vært lest av i rapportperioden, er det ingen 

tilgjengelige innstillinger.

Rapporten Daily Detail (Daglig detaljer)      

Rapporten Daily Detail (Daglig detaljer) viser glukosedata, 

karbohydratmengde og pasientens insulinbruk for den valgte dagen. 

Det lages en egen rapport for hver dag du velger i datatabellen.

Rapporten Daily Detail (Daglig detaljer) inneholder en detaljert 

oversikt for hver dag du velger. Du kan bruke rapporten til å fokusere 

på en bestemt dag hvis du tror det kan ha skjedd noe som har 

betydning for pasientens behandling den dagen.
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Eksportere data          

Du kan eksportere utstyrsdata som samles inn og lagres i CareLink 

Pro. Du får da alle dataene fra en pasients utstyr, slik at du kan bruke 

dem til statistikk eller til å lage spesialrapporter eller -diagrammer. 

CSV-filen kan importeres til Microsoft Excel eller visse kliniske 

statistikkprogrammer der du kan bearbeide dataene ytterligere.

CSV-filen inneholder data om utstyrets aktiviteter. Den viser for 

eksempel registrerte verdier fra blodsukkermåleren, hvilken pumpe 

som har mottatt verdien fra blodsukkermåleren og endringer i basal-

dosen.

MERK! Dette er en
avansert funksjon og
forutsetter at du er

kjent med rådataene
fra utstyret.

Funksjonen forutsetter
også at du mestrer

programvaren du
importerer CSV-filen

til.

Gjør følgende når du skal bruke eksportfunksjonen i CareLink Pro:

1 Klikk på pasientfanen eller klikk på knappen ÅPNE PASIENT og 

dobbeltklikk på pasientens navn.

2 Kontroller at arbeidsområdet Reports (Rapporter) vises.

3 Velg datoer og rapportlengde i feltet Duration (Varighet) eller 

From/Through (Fra og med / Til og med).

Den lengste perioden du kan velge, er 12 uker.

4 Klikk på lenken export selected data (eksporter valgte data).

Dialogboksen Export Data to CSV File (Eksporter data til CSV-fil)

vises.

5 Hvis du vil endre hvor CSV-filen skal lagres på datamaskinen, klikker 

du pilen til høyre for feltet Save in (Lagre i) og velger en plassering.

6 Hvis du vil endre navnet på filen, skriver du navnet inn i feltet File 

name (Filnavn).

7 Klikk på SAVE (Lagre).

lenken Eksporter 
valgte data
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MERK! Du finner mer
informasjon om dataene

som vises i CSV-filer, i
CSV-data på side 69.

CSV-filen er nå lagret på datamaskinen med den plasseringen du 

valgte. Du kan nå velge å importere filen inn i et annet program som 

støtter denne filtypen.
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Systemadministrasjon 8

Hva dette kapittelet inneholder
• Før du begynner: side 59

• Legge inn programvareoppdateringer: side 60

• Sikkerhetskopiere og gjenopprette databasen: side 61

Det er viktig at du regelmessig tar sikkerhetskopi av CareLink™ Pro-

databasen. Databasen lagrer alle data i pasientjournaler, 

inkludert profilinformasjon, beregnede utstyrsdata og rapport-

innstillinger. 

CareLink Pro har funksjon for lagring og gjenoppretting av 

databasekopier.

Det er også viktig at du bruker den nyeste versjonen av CareLink 

Pro. Det utgis jevnlig oppdaterte versjoner, og disse kan inneholde 

viktige forbedringer. Du kan velge om du vil søke etter opp-

dateringer eller få melding når en ny oppdatering er tilgjengelig.

Før du begynner

Du bør lage en rutine for sikkerhetskopiering slik at du utfører den til 

faste tider. Dette vil gjøre det enklere å ta kopiene regelmessig og 

redusere risikoen for tap av data. 

Under en sikkerhetskopiering eller gjenoppretting registrerer 

CareLink Pro om det er andre brukere som benytter programvaren 

på andre datamaskiner. Disse får melding slik at de kan lagre 
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arbeidet sitt. Det vil imidlertid være en god rutine å kontrollere om 

andre brukere er logget på før du utfører en av prosessene.

Legge inn programvareoppdateringer         

Motta oppdateringer automatisk

Det utgis oppdateringer av CareLink Pro-programvaren med jevne 

mellomrom. Følg trinnene nedenfor når du får melding om en 

oppdatering, slik at du får lastet ned den nyeste programvaren.

MERK! Du bør ta en
sikkerhetskopi av

database før du legger
inn en programvare-

oppdatering. Se
Sikkerhetskopiere en
database på side 61.

1 Kontroller at datamaskinen er koblet til Internett.

2 Du får en melding når det finnes en oppdatering av CareLink Pro. 

Deretter kan du velge å laste ned oppdateringen.

3 Klikk på DOWNLOAD (Last ned). (Hvis du klikker på CANCEL (Avbryt), 

lukkes meldingen om oppdateringen. Du kan laste ned oppdateringen 

senere.)

Det vises en advarsel som anbefaler at du tar en sikkerhetskopi av 

databasen.

4 Klikk på YES (Ja) for å sikkerhetskopiere databasen (se mer om dette 

i Sikkerhetskopiere en database på side 61). Klikk på NO (Nei) hvis 

du ikke vil ta en sikkerhetskopi.

Det vises en melding som bekrefter at den nye CareLink Pro-

versjonen er lastet ned.

5 Klikk på YES (Ja) for å bruke den nye CareLink Pro-versjonen. 

Programmet lukkes og åpnes igjen. Klikk på NO (Nei) hvis du vil 

vente med å lukke CareLink Pro og åpne det igjen.

Deaktivere automatiske oppdateringer

Følg instruksjonene nedenfor hvis du ikke vil motta automatiske 

meldinger om CareLink Pro-oppdateringer:

1 Gå til Tools > Options (Verktøy > Alternativer).

2 Klikk på kategorien General (Generelt).

3 I delen Communications (Kommunikasjon) fjerner du merket i 

avkrysningsboksen ved siden Automatically check for software 

updates (Søk etter programvareoppdateringer automatisk).
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Søke etter oppdateringer manuelt

Du kan søke etter CareLink Pro-oppdateringer når som helst.

MERK! Du bør ta en
sikkerhetskopi av

databasen før du legger
inn en programvare-

oppdatering. Se
Sikkerhetskopiere en
database på side 61.

1 Kontroller at datamaskinen er koblet til Internett.

2 Gå til Tools > Check for Software Updates (Verktøy > Søk etter 

programvareoppdateringer).

3 Du får en melding hvis det ikke finnes nye oppdateringer. Hvis det 

finnes en ny CareLink Pro-oppdatering, vises melding om dette. 

4 Følg instruksjonene i Motta oppdateringer automatisk på side 60.

Sikkerhetskopiere og gjenopprette databasen

Sikkerhetskopiere en database     

Følg instruksjonene nedenfor når du skal ta en sikkerhetskopi av 

databasen og lagre den på valgt sted.

1 Sørg for at alle pasientjournaler er lukket.

2 Gå til Tools > Backup Database (Verktøy > Sikkerhetskopier 

database).

MERK! Sikkerhetskopier
kan lagres på en

nettverksstasjon eller
på et flyttbart medium

(DVD, CD, USB-pinne
osv).

3 Hvis du vil endre hvor sikkerhetskopien skal lagres på datamaskinen, 

klikker du pilen til høyre for feltet Save in (Lagre i) og velger en ny 

plassering.

4 Hvis du vil endre navnet på sikkerhetskopien, skriver du navnet inn i 

feltet File name (Filnavn).

5 Klikk på SAVE (Lagre). En fremdriftsindikator vises mens databasen 

lagres.

Det vises en melding når sikkerhetskopieringen er ferdig.

6 Klikk på OK for å lukke meldingen.

Gjenopprette en database      

Det kan hende du vil gjenopprette databasen hvis den ikke lenger 

fungerer eller du ikke får tilgang til den.

FORSIKTIG! Når du gjenoppretter fra en sikkerhetskopi, mister du alle data som er lagret 
etter at sikkerhetskopien ble laget.

Følg instruksjonene nedenfor når du skal erstatte den aktuelle 

databasen med en sikkerhetskopi.

1 Sørg for at alle pasientjournaler er lukket.
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2 Gå til Tools > Restore Database (Verktøy > Gjenopprett database). 

3 Velg sikkerhetskopifilen som skal erstatte den aktuelle databasen 

(vanligvis den nyeste).

4 Klikk på OPEN (Åpne). Det vises en advarsel. Klikk på OK.

5 En fremdriftsindikator vises mens databasen gjenopprettes.

Det vises en melding når gjenopprettingen er ferdig.

6 Klikk på OK for å lukke meldingen.

Hvis du ikke får tilgang til systemet                

Hvis du prøver å bruke systemet mens en annen bruker holder på å 

sikkerhetskopiere eller gjenopprette, får du en melding om at 

systemet ikke er tilgjengelig. Du får ikke tilgang til systemet før 

kopieringen/gjenopprettingen er ferdig.

Gjør ett av følgende:

• Vent til prosessen er ferdig og til systemet igjen er tilgjengelig.

• Klikk på CANCEL (Avbryt) for å avslutte, og prøv igjen senere.
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Feilsøking 9

Hva dette kapittelet inneholder
• Generelle feil under bruk: side 63

• Feil under avlesing av utstyr: side 64

• Feil under oppretting av rapport: side 65

• Feil under sikkerhetskopiering og gjenoppretting: side 66

• Avinstallere programvaren: side 66

Dette kapittelet kan hjelpe deg med å løse problemer som kan 

oppstå når du bruker CareLink™ Pro-programvaren. Det inneholder 

også instruksjoner om avinstallering av CareLink Pro-program-

varen, i tilfelle du skulle få bruk for det.

Generelle feil under bruk

Rettigheter til å laste ned programvareoppdateringer fra Internett

Det kan hende du får en melding om at du ikke har tilstrekkelige 

rettigheter hvis du prøver å laste ned en programvareoppdatering 

fra Internett. Du må ha administratorrettigheter for å laste ned 

CareLink Pro-programvareoppdateringer.

1 Lukk CareLink Pro-programmet og start datamaskinen på nytt. 

2 Sørg for at en person med administratorrettigheter logger seg på 

datamaskinen.

3 Følg instruksjonene i Legge inn programvareoppdateringer på 

side 60.
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Ikke koblet til databasen

Hvis du får en feilmelding om at du ikke er koblet til databasen, angir 

det ett av følgende:

• Databasen er flyttet. Databasen må være plassert samme sted som 

ble valgt under installasjonen av CareLink Pro-programvaren. Hvis 

databasen er flyttet, må du flytte den tilbake til stedet som ble valgt 

under installasjonen.

• Du er ikke koblet til nettverksstasjonen der databasen finnes. Hvis 

databasen er på en nettverksstasjon, kan midlertidige feil i nett-

verket hindre at du får tilgang til stasjonen. Kontakt dataavdelingen 

for å få opprettet tilkobling til den nettverksstasjonen der databasen 

finnes. 

Glemt passord til CareLink Pro

Hvis ingen kan huske passordet som diabetesteamet bruker til å logge 

seg på CareLink Pro, må CareLink Pro-programvaren installeres på 

nytt og en ny database må opprettes. Når du har installert program-

varen på nytt, har du ikke lenger tilgang til pasientinformasjonen som 

var i den forrige databasen. Oppbevar passordet du brukte under den 

nye installasjonen, et sted du husker, slik at du ikke mister fremtidige 

data. 

Feil under avlesing av utstyr

Feil under avlesing av utstyr Forklaring

The selected serial port 
could not be opened. 
Another operation might be 
in progress on that port. 
Please wait until the port is 
available, or select another 
port.

Kontroller at den valgte com-porten ikke brukes 
av et annet program, eller velg en annen port. 
Start datamaskinen på nytt og prøv å lese av 
utstyret igjen. Det kan være feil på maskinvaren 
(kabler osv.) som er koblet til porten, eller feil på 
selve porten. Koble maskinvaren til en annen port 
og prøve å lese av utstyret igjen for å finne ut om 
det var problemet. 

Auto Detect could not find 
the device on any available 
port. Please check the cable 
connection, device battery & 
status and try again, or try 
specifying a serial port.

Kontroller koblingen mellom kabelen og PC-en, og 
kontroller at batteristatus er OK. Hvis dette 
fungerer, kan du prøve å angi den serieporten på 
PC-en som kabelen er koblet til, i stedet for å 
bruke Auto Detect (Autom. registrering). 
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Feil under oppretting av rapport

Flere dataoppføringer på samme dato

Hvis det er flere dataoppføringer på samme dato og klokkeslett for 

det samme utstyret, oppfatter systemet at det er en konflikt som det 

ikke kan løse. Rapporten for disse utstyrsdataene vil ikke omfatte de 

dataene som overlapper. 

Device not found at selected 
serial port. Please check the 
cable connection, device 
battery & status and try 
again, try selecting a 
different port, or try to Auto 
Detect the device.

Kontroller koblingen mellom kabelen og PC-en, og 
kontroller at batteristatus er OK. Hvis dette 
fungerer, kan du enten velge en annen serieport 
på PC-en eller velge Auto Detect (Autom. 
registrering).

Unable to communicate with 
the device. Please ensure 
you’ve attached and 
selected the correct device, 
check the cable connection, 
device battery and status, 
and try again.

Kontroller alle innstillinger som er valgt for 
avlesing av utstyret, inkludert utstyrsnavn, 
serienummer og type tilkobling. Kontroller også 
at utstyret, kabler og PC-en er koblet til riktig. 
Kontroller at utstyrets batteri- og alarmstatus er 
OK. Prøv avlesing igjen.

Unexpected response... 
retrying (n%)

Systemet avleste en uventet verdi fra utstyret. 
Systemet prøver å gjenoppta kommunikasjonen 
inntil du avbryter eller kommunikasjonen 
opprettes.

The communication device 
was found, but the pump 
(<serial #>) is not 
responding. Please verify the 
pump’s serial number, place 
the pump closer to the 
communication device to 
minimize interference, 
check pump battery and 
status.

Kontroller at riktig serienummer for pumpen er 
lagt inn. Hvis ikke må du skrive inn det riktige 
serienummeret. Hvis serienummeret er riktig, kan 
du prøve å flytte pumpen nærmere 
kommunikasjonsutstyret, flytte kommunikasjons-
utstyret og pumpen lengre unna eventuelle 
støykilder (som annet RF-utstyr) eller kontrollere 
pumpens batteri- og tilførselsstatus.

This pump is delivering a 
temp basal. Please cancel 
the temp basal or wait until 
it completes, and then try 
again.

Pumpen du prøver å avlese, holder på å tilføre en 
midlertidig basaldose. Du må enten vente med 
avlesing til den midlertidige basaldosen er ferdig, 
eller avbryte basaldosen og deretter lese av 
pumpen.

This pump has active errors 
or alarms. Please clear the 
alarms and try again.

Det finnes aktive alarmer i pumpen som hindrer 
avlesing. Les i alarminstruksjonene om hvordan 
du sletter alarmen. Slett alarmen og prøv å lese 
av pumpen igjen.

This pump is delivering a 
bolus. Please cancel the 
bolus or wait until it 
completes, and then try 
again.

Pumpen du prøver å avlese, holder på å tilføre en 
bolusdose. Du må enten vente med avlesing til 
bolusdosen er ferdig, eller avbryte bolusdosen og 
deretter lese av pumpen.

The device returned invalid 
entries; all data read will be 
discarded.

Kontakte den lokale Medtronic-representanten 
(se Brukerhjelp på side 3). 

Feil under avlesing av utstyr Forklaring
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Du kan eventuelt endre tidsrommet for rapporten slik at over-

lappende data ikke inkluderes. Du kan også koble utstyret fra 

systemet og deretter til igjen for å slette tidligere data.

Systemet ignorerer data

Hvis klokkeslettet på utstyret er endret og dette medfører over-

lappende data eller manglende data på tre timer eller mer, tar 

systemet ikke med den delen i rapportene.

Feil under sikkerhetskopiering og gjenoppretting

Databasen kan ikke låses

Dette betyr at systemet har flere brukere, og at andre brukere er 

logget på. Systemet tillater ikke sikkerhetskopiering av databasen 

mens andre brukere kan utføre oppgaver som påvirker databasen. Du 

kan ta sikkerhetskopi av databasen når alle andre brukere er logget 

av CareLink Pro.

En sikkerhetskopiering eller gjenoppretting av databasen er ikke 
fullført

Andre brukere kan ikke logge på og sikkerhetskopieringen eller 

gjenopprettingen kan ikke fullføres. Kontakt brukerstøtte eller den 

lokale representanten (se Brukerhjelp på side 3).

Gjenoppretting av databasen mislyktes

Sikkerhetskopien av databasen du prøvde å bruke til å gjenopprette, 

er ødelagt. Bruk en annen sikkerhetskopi til gjenoppretting.

Avinstallere programvaren

Slik avinstallerer du CareLink Pro:

1 Åpne Kontrollpanel fra Start-menyen i Windows.

2 Velg Legg til eller fjern programmer. Vinduet Legg til eller fjern 

programmer åpnes.

3 Bla ned til Medtronic Carelink Pro og marker dette.

4 Klikk på Fjern. Installasjonsveiviseren åpnes.

5 Klikk på Neste. En melding vises der du blir bedt om å bekrefte at du 

vil fjerne programmet.
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6 Klikk på Ja. Avinstalleringsprogrammet fjerner programmet og alle 

filene fra datamaskinen. Når programmet er fjernet, viser 

installasjonsveiviseren en melding som bekrefter avinstalleringen.

7 Klikk på Ferdig.
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Symboloversikt
I tabellen nedenfor finner du en beskrivelse av symbolene på 

emballasjen og utstyret.

Forklaring Symbol

Én per eske/pakning (1x)

OBS! Les bruksanvisningen.

CD er vedlagt

Viktige dokumenter er vedlagt

Artikkelnummer REF

CE-merket av godkjent organ som 
medisinsk utstyr
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T
il
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 A
 

CSV-data A

Dette tillegget beskriver hvilke data fra CareLink™ Pro som kan 

vises når du eksporterer til CSV-format. 

Definisjon av data i kolonner

Kolonneoverskrift Definisjon

Index (Stikkord) Rekkefølgen for registreringen av data i utstyret.

Date (Dato) Datoen for registreringen av data i utstyret.

Time (Klokkeslett) Klokkeslettet for registreringen av data i 
utstyret.

New Device Time 
(Ny utstyrstid)

Den nye datoen og det nye klokkeslettet, hvis 
dette ble endret i utstyret.

BG Reading (BS-verdi) 
(mg/dL eller mmol/L)

Blodsukkerverdien som ble registrert av 
blodsukkermåleren, Guardian eller pumpen. Hvis 
dataene kommer fra en pumpe eller Guardian, 
viser kolonnen de manuelle BS-målingene eller 
BS-verdier fra en Link-blodsukkermåler. 

Linked BG Meter ID 
(ID for tilkoblet BS-måler)

Serienummeret for den blodsukkermåleren som 
sendte en bestemt BS-verdi til utstyret.

Basal Rate (U/h) 
(Basaldose (E/tim)) Den aktive basaldosen i enheter per time.

Temp Basal Amount 
(Midlertidig basaldose) 

Denne verdien viser den midlertidige basaldosen, 
hvis en slik var programmert i pumpen.  

Temp Basal Type 
(Type midlertidig basaldose)

Hvordan den midlertidige basaldosen justeres 
(insulindose per time eller prosent av basal).

Temp Basal Duration 
(Varighet av midlertidig 
basaldose) (m)

Hvor lenge tilførselen av den midlertidige 
basaldosen varer, i minutter (se type ovenfor).

Bolus Type (Bolustype)
Type bolustilførsel [vanlig, forlenget, 
kombinasjon (vanlig del) eller kombinasjon 
(forlenget del)].
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Bolus Volume Selected (U) 
(Valgt bolusvolum (E))

Antall insulinenheter som er programmert til å 
tilføres under en bolustilførsel.

Bolus Volume Delivered (U) 
(Tilført bolusvolum (E))

Antall insulinenheter som faktisk ble tilført under 
bolustilførselen.

Programmed Bolus Duration 
(h) 
(Programmert bolusvarighet 
(t))

Varigheten av en forlenget bolus eller den 
forlengede delen av en kombinasjonsbolus.

Prime Type (Primetype)

Manuell eller fast. Manuell brukes rett etter en 
reversering for å fylle slangesettet med insulin 
før det settes inn. Fast brukes etter at slange-
settet er satt inn for å fylle den myke kanylen 
med insulin etter at innføringskanylen er fjernet.

Prime Volume Delivered (U) 
(Tilført primevolum (E))

Antall insulinenheter som faktisk ble tilført under 
primingen.

Alarm Navnet på alarmen som oppsto.

Suspend (Stoppet) Angir at pumpen har stoppet.

Rewind (Reverser) Dato og klokkeslett for reversering.

BWZ Estimate (U) 
(BWZ-beregning (E))

Estimert bolusinsulin som er beregnet av Bolus 
Wizard-funksjonen i Paradigm-pumpen.

BWZ Target High BG 
(BWZ-mål for høyt BS) 
(mg/dL eller mmol/L)

Innstillingen for den øvre verdien av målområdet 
for blodsukker - brukes av Bolus Wizard.

BWZ Target Low BG 
(BWZ-mål for lavt BS) 
(mg/dL eller mmol/L)

Innstillingen for den nedre verdien av mål-
området for blodsukker – brukes av Bolus Wizard.

BWZ Carb Ratio 
(BWZ-karbohydratforhold)

Innstillingen for insulin/karbohydrat-forholdet. 
Hvis gram brukes som enheter, angir forholdet 
hvor mange karbohydratgram som dekkes av en 
enhet insulin. Hvis bytter brukes som enheter, 
angir forholdet antall insulinenheter som dekker 
ett karbohydratbytte.

BWZ Insulin Sensitivity 
(BWZ-insulinsensitivitet)

Innstillingen for insulinsensitivitet. Insulin-
sensitiviteten er et tall på hvor mye blodsukker-
verdien reduseres når det tilføres én enhet 
insulin. Dette brukes av Bolus Wizard.

BWZ Carb Input 
(BWZ-karbohydratoppføring)

Antall karbohydrater som er lagt inn i Bolus 
Wizard, og som brukes til å beregne en bolus.

BWZ BG Input 
(BWZ BS-oppføring) (mg/dL 
eller mmol/L)

Blodsukkerverdier som er lagt inn i Bolus Wizard, 
og som brukes til å beregne en bolus.

BWZ Correction Estimate (U) 
(BWZ-korreksjonsberegning 
(E))

Antall enheter som skal tilføres for å korrigere 
blodsukkerverdien – beregnes av Bolus Wizard.

BWZ Food Estimate (U) 
(BWZ-matberegning (E))

Antall enheter som skal tilføres for å dekke det 
forventede karbohydratinntaket – beregnes av 
Bolus Wizard.

BWZ Active Insulin (U) 
(BWZ aktivt insulin (E))

Aktivt insulin som er beregnet til å være igjen i 
kroppen fra forrige bolustilførsel –  brukes av 
Bolus Wizard til å beregne bolusdosen.

Kolonneoverskrift Definisjon
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Mer informasjon om CSV-filer som eksporteres av 
CareLink Pro

Tittelen øverst i CSV-filen inneholder følgende informasjon:

• pasientens navn

• en liste over valgt utstyr og tilhørende serienumre

• valgt datoområde

Hver kolonneblokk har en tittel med følgende informasjon:

• navn på utstyret som dataene gjelder for

• utstyrets serienummer 

Hvis dataene ikke vises som forventet

Det kan være flere årsaker til at CSV-data vises annerledes enn 

forventet.

• Hvis dato eller klokkeslett endres på utstyret, kan det endre 

rekkefølgen eller føre til at registreringer utenfor det valgte 

datoområdet vises.

• Hvis det er et stort opphold mellom utstyrsverdier, kan data for det 

utstyret vises i flere blokker.

Sensor Calibration BG 
(Sensorkalibrering BS) 
(mg/dL eller mmol/L)

BS-verdien som brukes til å kalibrere sensoren (i 
mg/dl eller mmol/l).

Sensor Glucose 
(Sensorglukose) 
(mg/dL eller mmol/L)

Sensorglukoseverdien.

ISIG value (ISIG-verdi) Inngangssignaler (ISIG) som leses av sensoren. 
Målt i nanoampere (nA).

Kolonneoverskrift Definisjon
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Ordliste

A
A1c   Glykosylert hemoglobin

A1c-test  Hemoglobin-A1c-test. Brukes til å vurdere blodsukker-
verdier over en lengre tidsperiode.

Advarsel om lite i reservoar  Programmerbar advarsel som aktiveres 
når det er et definert antall enheter igjen i reservoaret, eller at det 
er igjen en definert tid før reservoaret er tomt.

Arealet under kurven (AUC)  Angir gjennomsnittlig antall høye eller 
lave verdier i tidsrommet som er valgt for sensoren.

B
Basaldose  Pumpeinnstilling som gir kontinuerlig infusjon av insulin 
for å holde blodsukkeret stabilt mellom måltider og i løpet av natten. 
Basalinsulin fungerer på samme måte som insulin fra 
bukspyttkjertelen - som dekker kroppens behov for insulin utenom 
måltider.

Basaldoseprofil  En basaldose med et start- og stopptidspunkt. 
Brukeren kan programmere flere forskjellige profiler i pumpen, hver 
med en egen dose i løpet av en 24 timers periode. Dette er for å 
oppnå bedre blodsukkerkontroll.

Basalinsulin  En kontinuerlig infusjon av insulin per time som tilføres 
automatisk av en insulinpumpe basert på forhåndsdefinerte profiler 
og personlige innstillinger i pumpen. Pumpen tilfører en daglig 
insulindose som normalt dekker det grunnleggende behovet for insulin 
ved faste (dvs. om natten og mellom måltider).

Basalprogrammer  Brukeren kan programmere opptil tre forskjellige 
programmer med basaldoser for tilførsel av basalinsulin: Standard, A 
og B. For hvert program kan det innstilles opptil 48 basaldoseprofiler.

Blodsukkermåler  Et medisinsk apparat som brukes til å fastslå 
omtrentlig konsentrasjon av glukose i blodet. En liten dråpe blod 
plasseres på en teststrimmel, som blodsukkermåleren leser av og 
bruker til å beregne blodsukkerverdien. Blodsukkermåleren viser så 
verdien i mg/dl eller mmol/l. 
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Blodsukkermålervalg  En funksjon som gjør at pumpen kan motta 
blodsukkerverdier fra en tilkoblet blodsukkermåler.

Bolusinsulin  En insulindose som gis for å dekke forventet økning i 
blodsukkeret (f.eks. økning etter et måltid eller mellommåltid) eller 
for å redusere høyt blodsukker til målområdet.

BS  Blodsukker

Bytteforhold  Insulinmengden som skal til for å dekke ett (1) 
karbohydratbytte. (Se også Karbohydratforhold.)

C
CareLink™ Personal  En nettbasert tjeneste som brukes til 
administrasjon av diabetesdata via Internett.

CareLink™ USB  Utstyr som brukes til å laste opp data fra en 
insulinpumpe i serien Medtronic Diabetes Paradigm eller en Guardian 
REAL-Time-monitor til CareLink™ -programvaren ved hjelp av en USB-
port på datamaskinen.

ComLink   Et apparat med en radiofrekvensmottaker for nedlasting 
av data til datamaskinen fra Paradigm-pumpen eller Guardian REAL-
Time.

Com-Station  Et apparat som brukes til å laste ned data fra 
MiniMed 508-pumper og blodsukkermålere fra andre produsenter.

D
Dual Wave®-bolus  (Kombinasjonsbolus). Kombinasjon av vanlig bolus 
som tilføres umiddelbart, etterfulgt av en forlenget bolus. Den 
forlengede delen tilføres jevnt i et tidsrom.

E
Easy Bolus™  Metode for tilførsel av en normal bolus ved hjelp av 
tasten Lydbolus på pumpen.

Ekspressbolus  Metode for tilførsel av alle bolustyper ved hjelp av 
tasten Ekspressbolus på pumpen.

F
Forlenget bolus-del  Andre del av en forlenget bolus. Forlenget 
bolus-delen tilføres jevnt over et tidsrom etter at NÅ-delen er tilført.

H
HbA1c   Glykosylert hemoglobin

HbA1c-test  Hemoglobin-A1c-test. Brukes til å vurdere blodsukker-
verdier eller gjennomsnittet av verdiene over en periode på 2 til 
3 måneder.
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Hyperglykemisk  For høyt blodsukker. Dette oppdages ved kontroll av 
blodsukkerverdier, og kan følges av et eller flere av følgende 
symptomer: kvalme, oppkast, uklart syn, hodepine, mageproblemer, 
hyppig vannlating og nedsatt bevissthet. 

Hypoglykemisk  For lavt blodsukker. Dette oppdages ved kontroll av 
blodsukkerverdier, og kan følges av et eller flere av følgende 
symptomer: kraftig sult, skjelvinger eller kramper, svette, "dansende" 
syn, svimmelhet, hodepine, uklar tale, plutselige humørsvinginger 
eller personlighetsforandringer.

Høy glukose  Pumpen utløser en alarm hvis sensoren angir at 
brukerens glukoseverdi er lik eller høyere enn denne verdien. Du kan 
velge om du vil slå denne funksjonen på eller av.

I
Insulinkonsentrasjon  Konsentrasjonen eller typen insulin som legen 
har foreskrevet. Dette påvirker hastigheten som pumpen bruker for å 
tilføre insulinet. Hvis brukeren bytter insulinkonsentrasjon, må 
basalprogrammer og maksimumshastigheter for basal- og bolusdoser 
omprogrammeres i pumpen.

Insulinsensitivitet  Hvor mye blodsukkeret reduseres i mg/dl (eller 
mmol/l) når det tilføres én enhet insulin. (Bolus Wizard-data.)

K
Kal.påminn.   Verdien for kalibreringspåminnelsen angir når pumpen 
skal aktivere en påminnelse om kalibrering. Verdien blir innstilt i 
forhold til hvor lang tid det er igjen til kalibreringsverdien ikke lenger 
er gyldig. Hvis kalibreringspåminnelsen for eksempel er satt til to 
timer, utløses alarmen BS-verdi kl. to timer før pumpen må 
kalibreres.

Karb.forhold - (karbohydratforhold).  Mengden karbohydrater som 
dekkes av én enhet insulin. (Se også bytteforhold.)

Karbohydratenheter  Matoppføringen når Bolus Wizard brukes. Angis 
i gram (karbohydrater) eller bytter.

Ketontest  Ketoner er et avfallsprodukt som produseres når kroppen 
blir tvunget til å omdanne fett til energi i stedet for glukose. Det kan 
være et tegn på at kroppen mangler insulin. Ketontesten måler 
konsentrasjonen av ketoner i blod eller urin.

KH  Karbohydrat

Korrigeringsdose  Insulinmengden som skal til for å redusere et høyt 
blodsukkernivå til målområdet.

Korrigeringsfaktor (sensitivitetsfaktor)  Hvor mye blodsukkeret blir 
redusert med 1,0 enhet insulin. Denne faktoren benyttes til å beregne 
korrigeringsdosen når blodsukkeret er høyt.
(BS-nivå) – (BS-mål) = X. 
X ÷ (korrigeringsfaktor) = 
korrigeringsdose
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L
Laste opp  Prosessen med å overføre data fra pumpen eller 
blodsukkermåleren til CareLink™ Personal-serveren.

Lav glukose  Pumpen utløser en alarm hvis sensoren angir at 
brukerens glukoseverdi er lik eller lavere enn denne verdien. Du kan 
velge om du vil slå denne funksjonen på eller av.

Link  Å slå på og definere det blodsukkermålervalget som gjør at 
pumpen kan ta imot blodsukkerverdier fra blodsukkermålere i serien 
CONTOUR® LINK, OneTouch® UltraLink™ eller Paradigm Link®.

Det brukes også i systemet for å referere til lenker. Da kalles det 
lenke. Når du har logget deg på, kan lenker åpne andre sider i 
systemet eller et annet nettsted.

Lydbolus  Pumpen kan programmeres slik at brukeren hører et 
lydsignal når han eller hun velger en bolusdose (f.eks. 0,5 eller 
1,0 enheter). Dette er nyttig i situasjoner der det er vanskelig å se 
pumpens taster.

M
Maks. basalinsulin  Den maksimale insulinmengden som pumpen kan 
tilføre på én gang. (Angitt av brukeren.)

Maksimal bolus  Den maksimal bolusmengden som pumpen kan tilføre 
på én gang. (Angitt av brukeren.)

Manuell bolus  Valgbart element i BOLUSMENY når Bolus Wizard er 
aktivert. En metode for programmering av bolus uten Bolus Wizard. 

Matbolus  En insulindose som tilføres for å dekke den forventede 
økningen av blodsukkeret som oppstår etter et måltid.

Midl.  Midlertidig

Midlertidig basaldose (midl. basal)  Midlertidig basalinsulin som 
tilføres én gang med spesifikk mengde og varighet. Brukes til å dekke 
insulinbehov ved spesielle aktiviteter eller tilstander som ikke er en 
del av den normale, daglige rutinen.

l  mikroliter  

P
Program A/B  Basalprogram som støtter aktivitetsnivåer som ikke er 
en del av hverdagsrutinen, men som er normale i forhold til livsstilen 
din. Det kan for eksempel dreie seg om en idrett du deltar i en gang i 
uken, eller en forandring i søvnmønsteret over helgen, lange perioder 
med høyere eller lavere aktivitet eller menstruasjon.
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R
RF  Radiofrekvens (RF) 

S
Sender-ID   Serienummeret på senderen som brukes.

Slangesett  En slange som brukes mellom en kanyle under huden og 
pumpen for å tilføre insulin til injeksjonsstedet.

Square Wave®-bolus  (Forlenget bolus). Bolus som tilføres over et 
brukerspesifisert tidsrom (30 minutter til 8 timer). 

Standardprogram  Den normale basaldosen som er tilpasset 
hverdagens aktiviteter. Når programfunksjonen er slått av, bruker 
pumpen ditt standardprogram (basal).

Stoppet  Funksjon som stopper all tilførsel av insulin. All bolus-
tilførsel og/eller priming stoppes. Basaltilførselen stoppes til den 
startes igjen. 

T
Trinn  Innstilt antall enheter insulin per tastetrykk ved tilførsel av 
lydbolus.

V
Vanlig bolus  En umiddelbar tilførsel av en spesifisert insulindose. 
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Stikkordregister

A
Advarsler 6
Aktivere utstyr 43
Alternativer på hovedmenyen 12
Arbeidsområder 10
Arbeidsområdet Devices

hente utstyrsdata 43
lagre utstyr 42

aktivere 43
deaktivere 42

legge til utstyr
blodsukkermålere 40

slette utstyr 43
Arbeidsområdet Devices (Utstyr)

legge til utstyr 37
Guardian-monitor 37
pumper 37

B
Bestilling

blodsukkermålere 5
Medtronic MiniMed-produkter 5
pumper 5
utstyr 5

Blodsukkermålere
aktivere 43
bestilling 5
deaktivere 42
ekstrautstyr til kommunikasjon 

med datamaskinen 35
hente data 43
koble til datamaskinen 33

BS-målervalg 35
Ekstrautstyr

ComLink 35
Com-Station 35

kabler
serie 34
USB 34

PC-tilkoblinger
serie 34

USB 34
legge til i systemet 40
slette 43
støttes 3

Blodsukkermålere som støttes 3
Blodsukkermålere som støttes av 

CareLink Pro 3
Blodsukkermålerkabel 4
Blodsukkermålernavn

tilsvarende utstyr 5
Brukergrensesnitt

Guide Me 13
aktivere 14

hjelpesystem 14
Learn more-lenker 14
menylinje 12
navigere i 9
statuslinje 9
verktøylinjen

knapper 12
Brukerhjelp 3

telefonnumre og adresser til 
nettsteder 3

Brukerhåndbok
ord, uttrykk og symboler 5
relevant dokumentasjon 2

Brukersikkerhet
advarsler 6
indikasjoner for bruk 6
kontraindikasjoner 6

Brukerstøtte 3
telefonnumre 3

C
CareLink Personal

hente data 30
koble seg til en konto 27

eksisterende konto 27
invitasjon på e-post 29

CareLink Pro
alternativer på hovedmenyen 12
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funksjoner 2
Guide Me-funksjon 13

aktivere 14
hjelpesystem 14
Learn more-lenker 14
Oversikt 1
sikkerhetsfunksjoner 2
statuslinje 9

ComLink 4, 35
Com-Station 4, 35
CSV-filer

eksportere utstyrsdata til 57

D
Daily Detail-rapport

om 56
Database

gjenopprette fra sikkerhetskopi 61
system ikke tilgjengelig 62

sikkerhetskopiere 61
system ikke tilgjengelig 62

Datakommunikasjonskabel 4
Datakommunikasjonskabel som 

støttes 4, 5
Datoer

velge for rapporter 53
Deaktivere utstyr 42
Dokumenter relevant for denne 

brukerhåndboken 2
E
Eksisterende CareLink Personal-konto

koble seg til 27
Eksportere utstyrsdata 57
Ekstrautstyr til kommunikasjon med 

datamaskinen
ComLink 35
Com-Station 35

F
Forhåndsvisning

rapporter 54
Forstå rapporter 55

Daily Detail-rapport 56
Loggbokrapport 56
Oversiktsrapport for sensoren og 

blodsukkermåleren 55
Responsrapport 55
Sammendrag av 

utstyrsinnstillinger 56
Funksjoner i CareLink Pro 2

sikkerhet 2
Få beskjed om inn 

programvareoppdateringer 60

G
Generelle innstillinger

innstilling 19
Generelle systeminnstillinger

forstå 18

innstilling 18
generelle innstillinger 19
innstillinger for pasientprofil 

20
endre rekkefølgen på 

felter 21
legge til egendefinerte 

felter 21
velge datafelter 20

innstillinger for pasientsøk 21
endre rekkefølgen på 

kolonne 22
innstillinger for 

rapportgenerering
endre rekkefølgen på 

kolonner 23
velge data 23

innstillinger for åpne pasient
velge data 22

Gjenopprette database 61
system ikke tilgjengelig 62

Grunnleggende CareLink Pro-oppgaver 
16

Guardian-monitor
legge til i systemet 37

Guardian-monitorer
deaktivere 42

Guide Me-funksjon for CareLink Pro 13
aktivere 14

H
Hente en pasients utstyrsdata 43
Hente utstyrsdata

fra CareLink Personal 30
koble seg til CareLink Personal 27

eksisterende konto 27
invitasjon på e-post 29

nye data til rapporter 49
Hjelpesystem for CareLink Pro 14
Hvordan bruke denne 

brukerhåndboken 5
I
Indikasjoner for bruk 6
Innstillinger

kontrollere for rapporter 51
system

forstå 18
innstilling 18

generelle innstillinger 19
innstillinger for 

pasientprofil 20
endre rekkefølgen på 

felter 21
legge til 

egendefinert
e felter 21

velge datafelter 20
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innstillinger for 
pasientsøk 21

endre rekkefølgen på 
kolonne 22

innstillinger for 
rapportgenererin
g 22

endre rekkefølgen på 
kolonner 23

velge data 23
innstillinger for åpne 

pasient
velge data 22

Innstillinger for pasientprofil
innstilling 20

endre rekkefølgen på felter 21
legge til egendefinerte felter 

21
velge datafelter 20

Innstillinger for pasientsøk
innstilling 21

endre rekkefølgen på kolonne 
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rapporter 54

Lagre en pasients utstyr i systemet 42
aktivere 43
deaktivere 42
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Oversiktsrapport for sensoren og 

blodsukkermåleren 55
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